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POWER POINT uncţionarea calculatoarelor Cursul II
 Obiectivele acestui curs sunt:
 Adăugarea de ClipArt într-o prezentare; Adăugarea de text cu ajutorul text box; Crearea unei prezentări Blank; Crearea de tabele; Crearea de „speaker notes” (însemnările
 prezentatorului); Crearea de „audience handouts” ( colaje pentru
 auditoriu); Publicarea unei prezentări pe Web; Inserarea de hiperlink-uri; Vizualizarea unei prezentări pe Web.
 Descriere
 Acest curs îşi propune să te perfecţioneze în tehnica construirii unei prezentări utilizând instrumentele puse la dispoziţie de aplicaţia Power Point. Tot în acest curs vei învăţa cum să publici sau cum să vizualizezi o prezentare ca pagină Web prin intermediul Internet-ului.
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 Lecţia1
 Obiectivele acestei lecţii sunt:
 Inserarea de header/footer (antet/subsol) într-o prezentare;
 Verificarea ortografiei; Adăugarea de ClipArt într-o prezentare; Adăugarea şi gruparea shapes (obiecte grafice)
 folosind bara Drawing sau WordArt; Aplicarea formatelor asupra obiectelor grafice Adăugarea de text pentru un obiect grafic
 utilizând text box; Utilizarea stiloului grafic în timpul unei
 prezentări; Slide color scheme.
 Cerinţe finale ale lecţiei
 La sfârşitul acestei lecţii va trebui să ştii următoarele:
 Să introduci antete şi subsoluri într-o prezentare;
 Să utilizezi facilităţile puse la dispoziţie de bara de unelte Drawing;
 Să aplici formate asupra obiectelor grafice;
 Să modifici schema de culori implicită pusă la dispoziţie de aplicaţia PowerPoint.
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 Poţi previzualiza cum va arăta prezentarea cu footer-ul creat de tine
 Adaugă header şi footer întregii prezentări
 INSERAREA DE HEADER/FOOTER (ANTET/SUBSOL)
 Dacă doreşti ca pe slide-urile din prezentare, sau pe colajele pentru auditoriu, să inserezi antete şi subsoluri vei parcurge paşii următori:
 Execută clic pe meniul View situat pe bara pe meniuri.
 Alege opţiunea Header and Footer.
 Această comandă va deschide caseta de dialog Header and Footer:
 Caseta de dialog are două taburi : unul pentru slide şi unul pentru însemnări şi colaje. Pentru fiecare tab în parte poţi stabili seturi de antete şi subsoluri. Caseta se deschide implicit pe tabul Slide.
 Dacă doreşti ca pe slide-uri să-ţi apară data vei bifa opţiunea Date and time. Data va fi inserată în colţul din stânga jos. Există două posibilităţi de-a introduce data într-o prezentare:
 Update automatically – afişează şi actualizează automat data. Indiferent de ziua în care ai creat prezentarea pe slide-uri va fi afişata data curentă citită din calculator.
 Adaugă header şi footer numai slide-urilor selectate
 Adaugă data în footer-ul slide-urilor
 Adaugă numărul slide-ului în footer
 Adaugă textul editat în caseta Footer la Baza slide-ului
 Afişează footer-ul pe toate slide-urile
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 Fixed – afişează data şi ora editată de tine în caseta Fixed.
 Pentru a afişa în footer numărul slide-ului vei bifa opţiunea Slide number. Implicit în caseta de editare Footer vei găsi scris Power Point 2000. Aici vei edita textul care vrei să apară în footer pe fiecare slide sau pe toate. Dacă vrei ca pe slide-ul de titlu să nu-ţi apară footer vei avea grijă să bifezi opţiunea Don’t show on title slide.
 Când ai completat toate datele care vrei să-ţi apară în subsolul slide-urilor poţi să continui cu crearea de header şi footer pentru însemnări şi colaje. Pentru aceasta vei executa clic pe tab-ul Notes and Handouts. Se va deschide următoarea casetă de dialog :
 Dacă doreşti să adaugi şi data în header vei bifa opţiunea Date and time. În mod implicit este bifată opţiunea Fixed ceea ce-ţi permite să introduci data dorită de tine. Dacă doreşti ca data să se actualizeze automat vei bifa opţiunea Update automatically. Ca şi în cazul anterior poţi aplica header şi footer numai pe slide-ul curent sau pe toate dacă execuţi clic pe Apply to all. În acest moment caseta de dialog se închide. Deşi header-ele şi footer-ele adăugate de tine în prezentare nu sunt vizibile, ele există şi vor fi vizibile atunci când vei lista prezentarea sau o vei rula pe ecran.
 În capitolul următor vei învăţa cum să foloseşti opţiunea Spelling în cazul în care ai de făcut o prezentare în limba engleză şi doreşti să-ţi verifici din punct de vedere ortografic prezentarea.
 Caseta preview îţi afişează cum va arăta prezentarea cu header-ele şi footer-ele alese de tine
 Include data pe pagină
 Textul editat aici va fi adăugat ca header însemnărilor şi colajelor
 Textul editat aici va fi adăugat la baza slide-urilor
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 VERIFICAREA ORTOGRAFIEI ÎN PREZENTARE
 Aplicaţia Power Point 2000 ştie să identifice erorile de ortografie pentru limba engleză. Cuvintele scrise eronat vor fi subliniate cu linie ondulată roşie. Dacă vei executa clic-dreapta pe un astfel de cuvânt îl vei putea corecta, ignora sau adăuga în dicţionar.
 În cazul în care nu este bifată opţiunea care te va corecta în timp ce scrii şi dacă doreşti ca aplicaţia să-ţi ofere o mână de ajutor execută clic pe butonul Spelling de pe bara standard, sau apasă tasta F7, sau execută clic pe butonul Tools de pe bara de meniuri şi alege opţiunea Spelling.
 Meniul rapid care se desfăşoară când execuţi clic dreapta pe cuvântul scris greşit îţi pune la dispoziţie câteva sugestii de scriere a cuvântului respectiv. Ca în text să-ţi apară varianta corectă a cuvântului vei selecta varianta care se potriveşte în context şi vei executa clic pe ea. Dacă aplicaţia găseşte un cuvânt pe care nu-l are în dicţionar, chiar dacă acesta este scris corect, va fi semnalizat ca eroare de scriere. De obicei numele de persoane, oraşe, produse, vor fi semnalizate ca erori de scriere. În acest caz poţi face două lucruri, apelând la celelalte două opţiuni din meniul rapid:
 Ignore All – lasă cuvântul aşa cum l-ai scris şi-l va ignora ori de câte ori îl va întâlni în tot restul prezentării.
 Add – va adăuga cuvântul în dicţionar, astfel încât aplicaţia să nu-l mai semnalizeze ca fiind greşit. Vei apela la această opţiune pentru a introduce în dicţionar cuvinte care nu au traducere în limba engleză( nume,oraşe româneşti, etc) pe care le utilizezi mai des.
 Când apelezi la varianta Ignore All pentru un anume cuvânt acesta nu va mai fi subliniat cu roşu.
 Notă: De obicei în lista care apare vei găsi soluţia de scriere corectă pentru cuvântul respectiv. Dacă nu apare sugestia aşteptată aceasta înseamnă fie că respectivul cuvânt nu există în dicţionar, fie l-ai scris atât de greşit încât nu este de recunoscut.
 Eroare de scriere
 Sugestiile de scriere puse la dispoziţie de meniul rapid

Page 6
                        

6
 Notă: De semnalat că aplicaţia nu poate „prinde” toate greşelile de scriere. De exemplu: dacă în loc să scrii „had” (a avut) ai scris „hat” (pălărie) aplicaţia nu va semnaliza cuvântul ca fiind greşit, deoarece cuvântul „hat” există şi este scris corect.
 ADĂUGAREA DE CLIPART ÎNTR-O PREZENTARE
 Aplicaţia Power Point 2000 îţi pune la dispoziţie o galerie ce cuprinde câteva mii de obiecte grafice (imagini) pe care le poţi utiliza pentru a–ţi ilustra prezentarea. Galeria ClipArt are grupate obiectele grafice după anumite categorii cum ar fi: afaceri, sport, animale, vacanţe, etc. Această grupare îţi va uşura munca de căutare în interiorul galeriei ClipArt.
 Pentru a insera un obiect ClipArt într-o prezentare fie vei executa clic pe butonul Insert de pe bara de meniuri şi vei alege opţiunea Picture, iar din submeniul ce se derulează vei alege opţiunea ClipArt. Acelaşi efect îl vei obţine dacă vei executa clic pe butonul Insert ClipArt de pe bara de unelte Drawing situată la baza ferestrei deschisă de aplicaţie. Indiferent de calea aleasă pentru inserarea de obiecte ClipArt se va deschide caseta de dialog Microsoft Clip Gallery.
 În această galerie imaginile sunt grupate pe categorii şi dacă în caseta Search for clips vei tasta numele a ceea ce cauţi şi vei executa Enter se va deschide o altă casetă şi vei avea posibilitatea să alegi imaginea dorită. Aceeaşi casetă se va deshide şi dacă selectezi o anume categorie din cele afişate în caseta Insert ClipArt.
 Caseta de dialog îţi pune la dispoziţie şi alte facilităţi:
 - te duce în ecranul anterior;
 - îţi va afişa toate categoriile. Acelaşi efect îl are şi combinaţia de taste ALT+Home;
 - îţi permite să imporţi imagini din alte foldere. Acelaşi efect îl are şi combinaţia de taste ALT+I;
 - îţi permite să imporţi imagini direct din Internet. Acelaşi efect îl are şi combinaţia de taste ALT+C.
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 - tab-ul Pictures îţi pune la dispoziţie galeria de imagini artistice;
 - tab-ul Sounds îţi pune la dispoziţie, în funcţie de categoria de imagini pe care ai ales-o, diferite efecte sonore pe care le poţi adăuga imaginii respective;
 - tab-ul Motion Clips îţi permite să adaugi efecte de animaţie imaginii pe care ai ales-o.
 Dacă imaginea grafică pe care o doreşti nu există în prima casetă vei executa clic pe hiperlink-ul Keep Looking pentru a parcurge toate imaginile puse la dispoziţie la categoria respectivă.
 Când ai găsit imaginea care se potriveşte cel mai bine dorinţelor tale vei executa clic pe imaginea respectivă. În dreaptul imaginii selectate se va deschide un meniu şi vei executa clic pe butonul Insert Clip . Când execuţi clic pe butonul Insert Clip caseta de dialog Insert ClipArt se închide.
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 În afară de butonul Insert ClipArt meniul desfăşurat mai are următoarele opţiuni:
 Butonul Preview va deschide caseta Preview în care poţi vedea imaginea la o scară mai mare.
 Butonul Add ClipArt to Favourites or other category îţi permite să adaugi imaginea selectată fie în folder-ul favourites, fie să-l încadrezi şi în altă categorie. După ce selectezi noua categorie în care vrei să-l încadrezi execută clic pe Add.
 Butonul Find Similar Clips îţi permite să cauţi şi alte imagini similare după anumite criterii:
 ♦ Stilul artistic să fie similar cu cel al imaginii alese;
 ♦ Culoarea şi forma să fie similare cu cele ale imaginii alese;
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 ♦ Căutarea de imagini după cuvinte cheie care definesc cel mai bine imaginea aleasă.
 REDIMENSIONAREA IMAGINILOR CLIPART
 Dacă imaginea inserată este prea mare vei putea s-o redimensionezi astfel încât ea să corespundă cerinţelor tale. Pentru aceasta ai la dispoziţie două metode:
 Cu ajutorul mouse-ului :
 ♦ Execută clic pe imaginea inserată; În jurul imaginii vor apare reperele ( mici pătrate transparente );
 ♦ Poziţionează cursorul mouse-ului pe reperul din colţul stânga jos;
 ♦ Când cursorul se transformă într-o săgeată dublă înclinată execută clic pe butonul stâng al mose-ului şi ţine-l apăsat;
 ♦ Trage mouse-ul pe diagonală spre colţul dreapta sus;
 ♦ Când imaginea a ajuns la dimensiunea dorită eliberează butonul stâng al mouse-ului.
 Prin deschiderea casetei de dialog Format Object :
 ♦ Execută clic pe imagine;
 ♦ Poziţionează cursorul mouse-ului pe unul din reperele imaginii, sau în interiorul ei;
 ♦ Când cursorul se transformă într-o săgeată dublă înclinată sau în execută clic dreapta;
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 ♦ Din meniul rapid ce se desfăşoară alege opţiunea Format Picture... Aceasta va avea ca efect deschiderea casetei de dialog Format Picture.
 ♦ Caseta se deschide implicit pe tab-ul Picture.Execută clic pe tab-ul Size.
 ♦ În partea inferioară a casetei, la opţiunea Scale, vei introduce procentul până la care vrei să ajungă dimensiunea imaginii. Procentul îl poţi edita direct în câmpurile Height şi Width sau îl poţi stabili din săgeţile de incrementare şi decrementare corespunzătoare fiecărei dimensiuni.
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 ♦ După ce-ai stabilit noua dimensiune execută clic pe OK.
 MUTAREA IMAGINILOR CLIPART
 Dacă imaginea ClipArt inserată nu se află în locul dorit de tine o poţi muta utilizând procedeul „drag and drop” ( trage şi plasează ). Pentru aceasta execută paşii:
 Selectează imaginea executând clic în interiorul ei;
 Ţine butonul stâng apăsat şi trage mouse-ul în direcţia dorită;
 Când imaginea a ajuns în locul dorit eliberează butonul mouse-ului.
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 ADĂUGAREA DE FORME GRAFICE
 Bara de unelte Drawing este situată la baza ferestrei deschisă de aplicaţie şi conţine instrumentele care te vor ajuta să desenezi linii, diverse forme predefinite precum şi acele unelte necesare formatării obiectelor grafice aplicându-le culori, umbre şi efecte 3D.
 Primul pas este selectarea slide-ului unde vei dori să introduci formele grafice. În funcţie de tipul de formă grafică pe care vrei s-o introduci execută clic pe butonul corespunzător de pe bara Drawing.
 În acest moment indicatorul mouse-ului se transformă într-un +, ceea ce-ţi indică că acum poţi desena forma aleasă.
 Afişează meniul Drawing
 Afişează meniul cu forme predefinite
 Desenează dreptunghi
 Inserează imagini ClipArt
 Selector de obiecte
 Buton de rotaţie
 Desenează linie
 Desenează săgeţi
 Desenează oval
 Inserează casetă de text
 Inserează WordArt
 Aplică culoare de fundal
 Schimbă culoarea liniei
 Schimbă culoarea font-ului
 Grosimea liniei
 Tipul liniei
 Tipul de săgeţi
 Aplică umbre
 Aplică efecte 3D
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 Plasează indicatorul mouse-ului în punctul de unde doreşti să începi trasarea formei grafice. Execută clic pe butonul stâng al mouse-ului, ţine-l apăsat şi trage până când forma grafică ajunge la dimensiunea dorită. Eliberează butonul mouse-ului.
 Dacă doreşti să desenezi cercuri, pătrate sau linii perfect drepte vei ţine apăsată tasta <SHIFT> în timp ce desenezi forma grafică aleasă.
 Pe bara de unelte Drawing, în afara butoanelor care-ţi permit să desenezi linii, săgeţi, dreptunghiuri, ovale, există butonul AutoShapes care-ţi pune la dispoziţie peste o sută de forme şi linii predefinite. Când execuţi clic pe butonul AutoShapes se va derula un meniu organizat pe diverse categorii:
 Lines (linii): îţi permite să desenezi linii drepte, linii curbe, linii frânte şi forme oarecare.
 Connectors (Conectori): îţi permite să desenezi diverse tipuri de linii pentru a face conexiuni între diversele forme şi obiecte grafice.
 Basic Shapes (Forme geometrice de bază): îţi permite să desenezi figuri şi corpuri geometrice: pătrate, dreptunghiuri, triunghiuri, cercuri, cuburi, etc.
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 Block Arrows (săgeţi): îţi permite să desenezi săgeţi orientate sus, jos, stânga, dreapta.
 Flowchart (elemente scheme logice): îţi pune la dispoziţie formele de bază care intră în alcătuirea unei scheme logice sau în ilustrarea unui flux tehnologic.
 Stars & Banners (stele şi banner-e): îţi permite să introduci într-o prezentare forme artistice de stele şi banner-e. În interiorul acestor forme poţi să introduci un text cât mai semnificativ pentru prezentare dacă execuţi clic dreapta pe forma respectivă şi din meniul rapid care se desfăşoară alegi opţiunea Add Text.Textului pe care-l introduci poţi să-i aplici diverse formate.
 Callouts (comunicări): îţi permite să introduci casete de text cu forme predefinite (asemănătoare casetelor de dialog din revistele cu benzi desenate).
 Action Buttons (butoane de navigare): îţi permite să introduci butoane de navigare( similare cu butoanele de navigare ale unui aparat video) pe care le poţi
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 folosi pentru saltul de la un slide la altul sau pentru a-l asimila unei macro-comenzi.
 SELECTAREA, REDIMENSIONAREA, MUTAREA ŞI ŞTERGEREA FORMELOR GRAFICE
 Înainte de-a edita, formata, redimensiona, muta sau şterge formele grafice incluse pe un slide va trebui să selectezi acea formă.
 Când selectezi un obiect grafic de jur împrejurul marginilor vor apare reperele. Ele te vor ajuta să-i modifici dimensiunea şi să păstrezi proporţiile. Pentru a redimensiona o formă grafică execută paşii:
 Selectează obiectul grafic. Aceasta se realizează dacă execuţi clic în interiorul formei sau dacă apeşi succesiv tasta <TAB> până când se va selecta forma dorită;
 Poziţionează cursorul mouse-ului pe reperul din colţul stânga jos. Când cursorul mouse-ului se transformă într-o săgeată dublă execută clic şi ţine apăsat butonul mouse-ului în timp ce tragi spre dreapta şi în jos. În timp ce tragi va apare o linie punctată care te va ajuta să redimensionezi figura.
 Eliberează butonul mouse-ului când forma grafică a ajuns la dimensiunea dorită.
 Dacă doreşti să păstrezi şi proporţiile atunci când tragi vei ţine apăsată tasta <SHIFT>.
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 MUTAREA FORMELOR GRAFICE
 Pentru a muta formele grafice de pe un slide dintr-un loc în altul vei apela la metoda „drag and drop” (trage şi plasează)şi vei urma paşii:
 Selectează forma grafică;
 Poziţionează indicatorul mouse-ului în interiorul formei;
 Execută clic, ţine apăsat butonul şi trage până când forma ajunge în locul dorit. Linia punctată care apare te ajuta să vizualizezi locul unde va fi mutată forma grafică.
 Eliberează butonul mouse-ului.
 Dacă după ce ai mutat forma grafică vei dori să o mai muţi dar foarte puţin te vei ajuta de tastatură şi anume de tastele săgeţi şi tasta <CTRL>. Această combinaţie de taste te va ajuta să muţi formele grafice cu o mai mare precizie.
 COPIEREA FORMELOR GRAFICE
 Pentru a copia formele grafice de pe un slide vei apela tot la metoda „drag and drop” şi vei urma paşii:
 Selectează forma grafică;
 Poziţionează indicatorul mouse-ului în interiorul formei grafice;
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 Execută clic, ţine apăsat butonul şi în plus ţine apăsată tasta <CTRL>.Trage până când forma ajunge în locul dorit. Linia punctată care apare te ajuta să vizualizezi locul unde va fi copiată forma grafică.
 Eliberează butonul mouse-ului.
 ŞTERGEREA FORMELOR GRAFICE
 Pentru a şterge o formă grafică execută paşii:
 Selectează forma grafică pe care doreşti să o ştergi;
 Apasă tasta <DELETE>.
 RECAPITULAREA MANEVRELOR UTILIZATE
 Iată pe scurt o recapitulare a efectelor obţinute utilizând mouse-ul şi combinaţiile de taste:
 Dacă ţii apăsată tasta În timp ce tragi de: Obţii următorul efect
 Nici una Repere Redimensionarea formei grafice
 <SHIFT> Repere Păstrarea proporţiilor formei grafice în timpul redimensionării
 <CTRL> Repere Menţinerea centrată a formei grafică în timpul redimensionării
 Nici una Forma grafică Mutarea formei grafice
 <SHIFT> Forma grafică Mutarea formei grafice de-a lungul unei linii drepte orizontală sau verticală
 <CTRL> Forma grafică Copierea formei grafice
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 FORMATAREA OBIECTELOR GRAFICE
 Pentru a formata un obiect grafic vei urma paşii:
 Selectează obiectul grafic;
 Poziţionează cursorul mouse-ului pe oricare din repere. Când cursorul mouse-ului se transformă într-o săgeată dublă execută clic dreapta.
 Se va deschide caseta de dialog Format AutoShape. În mod implicit caseta se deschide pe tab-ul Colors and Lines (culori şi linii ).
 ♦ Opţiunea Fill îţi dă posibilitatea să schimbi culoarea de umplere a obiectului grafic. Acelaşi efect îl obţii dacă execuţi clic pe butonul Fill Color de pe bara de unelte Drawing sau dacă execuţi clic pe butonul Format situat pe bara de meniuri şi alegi opţiunea Format AutoShape. Opţiunea Line îţi dă posibilitatea să schimbi culoarea, stilul şi grosimea liniei care înconjoară obiectul grafic sau să renunţi la ea. Acelaşi efect de schimbare a culorii liniei îl obţii dacă execuţi clic pe butonul Line Color
 de pe bara de unelte Drawing sau dacă execuţi clic pe butonul Format situat pe bara de meniuri şi alegi opţiunea Colors and lines. Dacă doreşti să modifici stilul liniei poţi apela şi la bara Drawing. Vei executa clic pe
 Selectează stilul liniei
 Schimbă culoarea de umplere a obiectului
 Schimbă culoarea liniei
 Selectează grosimea liniei
 Transformă setările în setări implicite
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 butonul Line Style şi vei alege stilul dorit. Dacă. doreşti să înconjuri obiectul grafic cu linie punctată vei executa clic pe butonul Dash Style şi vei alege stilul dorit.
 ♦ Opţiunea Arrows îţi permite să stabileşti modelul de început şi sfârşit în cazul în care doreşti să desenezi săgeţi. Acelaşi efectîl obţii dacă execuţi clic pe butonul Arrow Style de pe bara de unelte Drawing.
 ♦ Opţiunea Semitransparent îţi dă posibilitatea să faci transparent un obiect grafic.
 Tab-ul Size te ajută să redimensionezi, să roteşti obiectul grafic. În caseta Height din săgeţile de incrementare şi decrementare stabileşti înălţimea obiectului grafic. În caseta Width din săgeţile de incrementare şi decrementare stabileşti lăţimea obiectului grafic. Dacă doreşti să roteşti obiectul grafic în caseta Rotation fie introduci numărul de grade cu care vrei să roteşti obiectul, fie execuţi clic pe săgeţile de incrementare şi decrementare. În partea de jos a casetei vei putea să redimensionezi obiectul. Dacă bifezi opţiunea Lock aspect ratio vei redimensiona obiectul grafic cu acelaşi procent şi pe înălţime şi pe lăţime.
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 Opţiunea Position îţi permite să stabileşti poziţia obiectului grafic pe slide atât pe orizontală cât şi pe verticală. Poziţia obiectului pe slide este relativă faţă de colţul stânga sus.
 ALTERNATIVE DE UMPLERE A OBIECTELOR GRAFICE UTILIZÂND OPŢIUNEA FILL COLOR
 Dacă doreşti să utilizezi diferite moduri de umplere a obiectelor grafice vei executa clic pe săgeata derulantă din dreptul casetei Color care va desfăşura lista ascunsă de culori. Culorile sunt organizate într-o paletă de culori denumită Color palette color. Aceasta îţi pune la dispoziţie mai multe variante:
 Opţiunea No Fill – nu umple obiectul grafic;
 Opţiunea Automatic – aplicaţia îţi propune o culoare de umplere din cele opt culori de bază situate mai jos. În partea de mijloc se află o gamă mai mare de culori. Dacă nici o culoare din cele existente în această casetă nu te satisfac poţi apela la următoarea opţiune.
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 Opţiunea More Colors... va deschide caseta de dialog Colors. Aceasta are două tab-uri. Tab-ul Standard îţi pune la dispoziţie sute de culori. Dacă te poziţionezi cu mouse-ul pe una din culori, în caseta de vizualizare din colţul dreapta jos, vei vedea în partea superioară noua culoare, iar în partea de jos culoarea curentă. Tab-ul Custom îţi dă posibilitatea să modifici luminozitatea, intensitatea culorilor şi gradul de saturaţie.
 Opţiunea Fill Effects te ajută să aplici efecte cromatice obiectelor grafice. Se va deschide o nouă casetă de dialog Fill Effects ce cuprinde patru tab-uri.
 ♦ Tab-ul Gradient – îţi dă posibilitatea să umpli obiectul grafic în gradienţi de culoare. Dacă bifezi opţiunea One Color umplerea se va face cu o singură culoare în degrade. Dacă bifezi opţiunea Two Colors umplerea se va face în două culori. Alegerea culorilor se face din casetele Color1 şi Color2 derulând listele ascunse de culori. Dacă bifezi opţiunea Preset aplicaţia îţi va propune o combinaţire de culori. În partea inferioară a casetei de dialog va trebui să alegi modul în care se va realiza umplerea. Ai la dispoziţie următoarele variante: Horizontal (umplerea pe orizontală), Vertical (umplerea pe verticală), Diagonal up (umplerea ascendentă pe diagonală), Diagonal Down (umplerea descendentă pe diagonală), From corner (umplerea pornind dintr-un colţ), From Center (umplerea pornind din centrul obiectului grafic). În caseta Variants poţi alege una din variantele de umplere care te avantajează cel mai bine. In caseta Sample poţi vizualiza cum va arăta obiectul grafic asupra căruia ai aplicat efectul de umplere.
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 ♦ Tab-ul Texture - îţi dă posibilitatea, ca în loc de culori, să foloseşti diverse modele de texturi pentru a umple obiectul grafic. În funcţie de textura aleasă în caseta Sample poţi vizualiza modul în care se va face umplerea. Când selectezi o anume textură în caseta de mai jos se va afişa numele modelului ales. Dacă apeşi butonul Other Texture vei putea să alegi alte modele decât cele afişate anterior.
 ♦ Tab-ul Pattern- îţi dă posibilitatea, ca în loc de culori, să foloseşti diverse modele de haşuri şi motive geometrice pentru umplere. Caseta Foreground îţi dă posibilitatea să alegi culoarea pentru linia de haşură sau motivul geometric din prim-plan executând clic pe săgeata de derulare a listei ascunse. Caseta Background îţi dă posibilitatea să alegi culoarea pentru fundal. Vei executa clic pe săgeata de derulare a listei ascunse şi vei selecta culoarea dorită.

Page 23
                        

23
 În caseta Sample vei vizualiza în detaliu modelul ales pentru umplere. Numele modelului ales îl poţi vedea în caseta situată sub modele.
 ♦ Opţiunea Picture îţi permite să umpli un obiect grafic cu o imagine pe care poţi s-o imporţi din alt fişier. Se deschide caseta de dialog Select Picture. După ce selectezi fişierul ce conţine imaginea dorită execută clic pe butonul Insert.
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 INSERAREA ŞI FORMATAREA IMAGINILOR
 Dacă în galeria ClipArt nu găseşti imaginea potrivită pentru prezentarea ta vei putea importa o imagine din alt fişier. Vei executa clic pe butonul Insert de pe bara de meniuri şi vei alege opţiunea Picture. Din submeniul care se derulează vei alege opţiunea From file. Se va deschide caseta de dialog Insert Picture.
 În caseta Look in vei selecta folder-ul în care se găseşte prezentarea. În mod implicit în caseta Look in vei găsi folder-ul My Pictures. Dacă prezentarea de găseşte în alt folder decât My Pictures din săgeata de derulare vei putea selecta folder-ul respectiv. În momentul în care selectezi o imagine în partea stângă a casetei, în partea dreaptă se va afişa imaginea respectivă. În câmpul File name vei alege numele imaginii. În câmpul Files of type ( fişiere de tipul) vei găsi în mod implicit All Pictures (fişiere de tip Picture). Dacă doreşti să alegi alt tip de fişier vei expanda lista ascunsă executând clic pe săgeata de derulare. După ce ai ales imaginea pe care doreşti s-o inserezi vei executa clic pe butonul Insert. Dacă vrei să o muţi în alt loc execută clic pe imagine şi deplaseaz-o acolo unde doreşti. În caseta Insert Picture mai întâlneşti următoarele butoane care îţi oferă următoarele facilităţi:
 Permite întoarcerea la un ecran anterior.
 Permite întoarcerea la un nivel de subordonare superior.
 Permite accesul rapid la browser-ul de Internet.
 Permite ştergerea obiectului selectat.
 Permite crearea unui nou folder în folderul afişat în câmpul Look in.
 Permite alegerea a diferite moduri de vizualizare a conţinutului unui folder precum şi vizualizarea conţinutului fişierului.
 Permite găsirea, ştergerea, tipărirea, maparea de drivere, etc.
 O serie de alte butoane îti oferă alte facilităţi:
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 Permite vizualizarea fişierelor cel mai recent utilizate.
 Permite vizualizarea conţinutului folderului My Documents.
 Permite vizualizarea conţinutului Desktop-ului.
 Permite crearea de legături spre foldere de pe calculatorul personal sau din reţeau la care eşti conectat sau la Internet.
 Permite accesul la foldere din Internet sau Intranet.
 Pentru a formata imaginea introdusă vei afişa bara de unelte Picture. Execută clic pe butonul View de pe bara de meniuri. Alege opţiunea Toolbars. Din submeniul care de derulează alege Picture. Pe ecran se va afişa bara de unelte Picture.
 Bara de unelte Picture seamănă cu un atelier fotografic care-ţi pune la dispoziţie o mulţime de unelte pentru ajustarea şi formatarea imaginilor inserate.
 Butonul Image Control te ajută să schimbi gama de culori. Când execuţi clic pe acest buton se va deschide un meniu ce are selectată implicit opţiunea Automatic. Culorile imaginii inserate vor fi cele originale. Opţiunea Grayscale va transforma culorile imaginii în tonuri de gri.
 Inserează imagine
 Control imagine
 Măreşte contrastul
 Micşorează contrastul
 Măreşte luminozitatea
 Micşorează luminozitatea Micşorează luminozitatea
 Restrânge imaginea
 Stilul liniei
 Formatare imagine
 Schimbă culorile
 Stabileşte transparenţa culorilor
 Resetează modificările
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 Opţiunea Black &White va transforma imaginea colorată într-o imagine alb-negru. Opţiunea Watermark va transforma imaginea colorată într-o imagine transparentă.
 Dacă imaginea inserată este prea mare o poţi îngusta dacă execuţi clic pe butonul Crop de pe bara de unelte Picture. Indicatorul mouse-ului se va transforma în simbolul butonului Crop. Acum poţi redimensiona imaginea. Pentru a redimensiona imaginea pe lăţime vei poziţiona indicatorul mouse-ului pe reperul din dreapta centru, execută clic pe butonul stâng al mouse-ului, ţine apăsat butonul şi trage de margine spre stânga. Linia punctată care apare te ajută să vezi până unde ai îngustat imaginea. Când dimensiunea este cea pe care o doreşti eliberează butonul mouse-ului.
 Pentru a reduce şi înălţimea imaginii execută clic pe reperul din centrul marginii inferioare, ţine butonul apăsat şi trage de margine în sus până când înălţimea imaginii
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 ajunge cea pe care o doreşti. Eliberează butonul mouse-ului. Dacă imaginea arată convenabil execută din nou clic pe butonul Crop de pe bara Picture.
 INSERAREA ŞI FORMATAREA OBIECTELOR WORDART
 WordArt este un instrument grafic care te ajută să introduci texte ce au aplicate efecte predefinite în galeria WordArt. Acesta este un program independent care este folosit şi de alte programe Microsoft Office cum ar fi Word sau Excel.
 Poţi introduce obiecte WordArt dacă execuţi clic pe butonul Insert de pe bara de meniuri, alegi opţiunea Picture şi din submeniul care se derulează alegi WordArt sau dacă execuţi clic pe butonul Insert WordArt de pe bara de unelte Drawing.
 Indiferent de metoda aleasă se va deschide caseta de dialog WordArt Gallery. Această galerie îţi pune la dispoziţie diverse stiluri de scriere artistică.
 Din această casetă vei alege modelul de scriere şi vei executa clic pe butonul OK.
 Se va deschide o nouă casetă de dialog denumită Edit WordArt Text. În partea superioară a casetei vei stabili formatul textului pe care-l vei introduce.
 În caseta Font vei alege tipul scrisului. Implicit, în casetă este ales font-ul Impact. Pentru a alege alt tip de font vei executa clic pe săgeata de derulare care-ţi va desfăşura lista ascunsă de font-uri.
 În caseta Size vei alege mărimea scrisului. Dacă execuţi clic pe săgeata de derulare se va desfăşura o listă cu mai multe dimensiuni de scris. Dacă doreşti ca
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 scrisul să apară îngroşat sau înclinat vei executa clic pe butoanele corespunzătoare Bold şi Italic.
 Caseta Text – îţi permite să editezi textul care vrei să apară.
 Când execuţi clic pe butonul OK textul pe care l-ai editat va apare pe slide şi odată cu el bara de unelte WordArt.
 Bara de unelte WordArt îţi permite să modifici aspectul obiectului WordArt selectat.
 Butonul Edit Text - îţi permite să editezi textul introdus.
 Butonul WordArt Gallery - deschide caseta de dialog WordArt Gallery şi dacă doreşti vei alege alt stil pentru textul editat.
 Butonul Format WordArt - îţi permite să aplici noi formate obiectelor WordArt.
 Butonul WordArt Shape - îţi permite să modifici forma obiectelor WordArt.
 Butonul Free Rotate - îţi permite rotirea liberă a obiectului WordArt inserat.
 Modifică formatul Font-ului
 Caseta de editare a textului
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 Butonul WordArt Same Letter Heights - îţi permite să aduci literele mici la aceeaşi înălţime cu literele mari.
 Butonul WordArt Vertical Text - îţi permite să aranjezi textul editat din orientare pe orizontală în orientare pe verticală.
 Butonul WordArt Alignment - îţi permite să alegi modul de aliniere a obiectului grafic pe slide (aliniat la stânga, centrat, aliniat la dreapta, cuvintele şi literele aşezate unele sub altele).
 .
 Butonul WordArt Character Spacing - îţi permite să alegi modul de spaţiere a literelor din textul editat.
 Dacă vrei să muţi obiectul WordArt vei poziţiona cursorul mouse-ului pe obiect, şi când acesta se transformă în 4 săgeţi perpendiculare foloseşte procedeul „clic and drag” – trage şi plasează (execuţi clic, ţii butonul stâng apăsat şi tragi obiectul până la locaţia dorită, eliberează cursorul mouse-ului). Dacă vrei să schimbi înclinarea textului vei executa clic pe unul dintre reperele de ajustare : ţine butonul stâng apăsat şi deplasează mouse-ul stânga-dreapta până când textul atinge înclinaţia dorită, eliberează cursorul mouse-ului. Dacă vrei să micşorezi sau să măreşti obiectul grafic plasează indicatorul mouse-ului pe unul din repere şi când indicatorul mouse-ului se transformă într-o săgeată dublă execută clic, ţine butonul stâng apăsat şi trage până când obiectul atinge dimensiunea dorită, eliberează butonul mouse-ului.
 FORMATAREA OBIECTELOR GRAFICE WORDART
 Pentru a formata un obiect WordArt va trebui să-l selectezi. Apoi vei execura clic pe butonul Format WordArt Object de pe bara de unelte WordArt. Se va deschide caseta de dialog Format WordArt. Aceasta este alcătuită din şase tab-uri.
 Schimbă culoarea de umplere
 Schimbă culoarea liniei
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 Tab-ul Colors and Lines îţi permite să alegi diferite culori pentru umplerea obiectelor grafice şi pentru liniile din jurul lor. Din lista ascunsă Color a opţiunii Fill vei alege culoarea de umplere a obiectului grafic. În afară de paleta de culori poţi aplica efecte de umplere pe care le alegi din caseta de dialog Fill Effects.
 Din lista ascunsă Color a opţiunii Line vei putea schimba culoarea liniei care înconjoară obiectul grafic sau o vei putea anula. Din lista ascunsă a casetei Weight dacă execuţi clic pe săgeţile de incrementare şi decrementare vei putea schimba grosimea liniei, iar modelul ei din lista ascunsă a casetei Dashed.
 Dacă doreşti să modifici forma obiectului grafic vei executa clic pe butonul WordArt Shape de pe bara de unelte WordArt. Se va afişa o listă cu toate formele disponibile şi vei executa clic pe forma dorită. Obiectul WordArt îşi va modifica forma.
 Dacă doreşti să modifici distanţa dintre litere şi să le scrii mai spaţiat vei executa clic pe butonul WordArt Character Spacing . În mod implicit este selectată opţiunea Very Tight (foarte strâns) – literele par suprapuse ca în exemplele de mai sus.
 Forma implicită Forma modificată cu WordArt Shape
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 Opţiunea Tight (strâns) va aşeza literele „lipite” unele de altele.
 Opţiunea Normal va lăsa spaţiu între litere ca la introducerea unui text obişnuit.
 Opţiunea Loose (mai mic) va îngusta literele şi textul apare mai spaţiat.
 Opţiunea Very Loose ( şi mai mic) va îngusta literele şi mai mult, iar spaţierea literelor este mai mare.
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 ROTIREA UNUI OBIECT
 Atunci când am discutat despre obiecte grafice sau imagini care se pot introduce într-o prezentare am amintit faptul că acestora le poţi schimba poziţia sau le poţi roti. Dacă ai introdus în slide o formă geometrică cu ajutorul barei Drawing poţi realiza rotirea ei cu butonul de rotire astfel:
 Selectezi forma respectivă. Mânerele de selecţie au forma unor pătrate mici (fig.1)
 Apeşi butonul de rotire Free Rotate de pe bara cu instrumente Drawing. Aşa cum vezi în figura 2 mânerele de selecţie iau forma unor cerculeţe.
 Poziţionează cursorul mouse-ului pe un reper circular, ţii apăsat butonul stâng al mouse-ului şi tragi în sus sau în jos până aduci obiectul în poziţia dorită (fig.3).
 Eliberezi butonul mouse-ului.
 Tot pe bara cu instrumente Drawing există meniul Draw care conţine un submeniu Rotate or Flip. Acesta furnizează opţiuni suplimentare pentru rotirea obiectelor. Cum procedezi?
 Selectezi forma respectivă. Mânerele de selecţie au forma unor pătrate mici.
 Apeşi butonul Draw de pe bara cu instrumente Drawing. Pe ecran se derulează un meniu cu mai multe opţiuni.
 Execuţi clic pe opţiune şi efectul
 îl vezi imediat aplicat formei selectate.
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 Notă: În partea superioară a submeniului care s-a desfăşurat este o porţiune mică de altă culoare (albastră sau gri) care îţi permite „detaşarea” acestui submeniu şi
 transformarea lui în bară de sine stătătoare. Poţi activa această bară şi cu ajutorul meniului View, apoi Toolbars şi să selectezi Rotate or Flip.
 Indiferent dacă ai afişat această bară sau lucrezi direct pe meniul butonului Draw, să vedem care sunt opţiunile şi care este efectul lor?
 Free Rotate este cea similară butonului de sine stătător de pe bara cu instrumente Drawing despre care am discutat anterior. Cu ajutorul ei se roteşte liber obiectul selectat.
 Rotate Left permite rotirea spre stânga a obiectului selectat cu 90O (fig.1).
 Rotate Right permite rotirea spre dreapta a obiectului selectat cu 90O (fig.2).
 Flip Horizontal roteşte obiectul în jurul axei centrale pe orizontală, prezentându-l ca în oglindă (fig.3).
 Flip Vertical roteşte obiectul în jurul axei centrale pe verticală, răsturnându-l (fig.3).
 În momentul în care execuţi clic pe un obiect grafic vei observa că în afara mânerelor de selecţie (reprezentate ca nişte mici pătrate albe) mai apare un mic romb (care în general este colorat galben). Rolul lui este să-ţi permită schimbarea în plan 3D a reprezentării. În exemplul următor vezi care este efectul „tragerii” spre dreapta sau stânga a acestui marcaj.
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 ALINIEREA ŞI GRUPAREA OBIECTELOR GRAFICE
 Comanda Align se lansează dacă execuţi clic pe butonul Draw de pe bara de unelte Drawing şi execuţi clic pe opţiunea Align or Distribute. Comanda Align are ca efect fie alinierea obiectelor unele faţă de celelalte fie spaţierea la distanţe egale a obiectelor unele faţă de altele. Opţiunea Align or Distribute îţi va afişa un submeniu de unde vei alege opţiunea care te interesează..
 Pentru aceasta vei urma paşii:
 Selectează obiectele ţinând apăsată tasta Shift în timp ce execuţi clic pe obiectele respective. Acelaşi efect îl obţii dacă execuţi clic pe butonul Select Objects de pe bara de unelte Drawing. Butonul apare apăsat şi vei poziţiona cursorul mouse-ului în stânga şi deasupra obiectelor pe care le vei selecta. Execută clic, ţine butonul apăsat şi trage spre colţul dreapta jos până când toate obiectele sunt încadrate în casetă, eliberează cursorul mouse-ului. Pentru o selecţie precisă a obiectelor este recomandat să apelezi la prima metodă descrisă şi anume cea în care te foloseşti de tasta Shift.
 Execută clic pe butonul Draw de pe bara de unelte Drawing. Se va afişa un meniu şi vei executa clic pe opţiunea Align or Distibute. Din submeniul care se desfăşoară vei executa clic pe opţiunea care te avantajează.
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 Dacă ai ales de exemplu ca obiectele să fie aliniate pe centru -Align Center- acestea vor arăta astfel:
 Obiectele le poţi alinia la stânga, Align Left, pe centru, Align Center, la dreapta, Align Right, în orientare pe orizontală. Pentru a alinia obiectele grafice în orientare pe verticală vei alege una din opţiunile: Align Top pentru aliniere la partea superioară a slide-ului, Align Middle pentru alinierea pe centru şi Align Bottom pentru alinierea la baza slide-ului.
 Dacă doreşti ca distanţa dintre obiectele grafice să fie aceeaşi pe orizontală vei selecta opţiunea Distibute Horizontally sau dacă vrei ca distanţa dintre ele să fie egală pe verticală vei selecta Distribute Vertically.
 Există cazuri în care vei dori ca mai multe obiecte grafice să se comporte ca unul singur. De exemplu dacă doreşti să le copiezi sau să le muţi împreună va fi mai uşor să execuţi manevra o singură dată. Vei urma procedura:
 Primul pas este selectarea obiectelor grafice. Selecţia o vei face ţinând tasta <SHIFT> apăsată şi efectuând clic pe obiectele grafice care vrei să se comporte ca unul singur sau execuţi clic pe pe butonul Select Objects de pe bara de unelte Drawing. Butonul apare apăsat şi vei poziţiona cursorul mouse-ului în stânga şi deasupra obiectelor pe care le vei selecta. Execută clic, ţine butonul apăsat şi trage spre colţul dreapta jos până când toate obiectele sunt încadrate în casetă, eliberează cursorul mouse-ului.
 Execută clic pe butonul Draw de pe bara de unelte Drawing. Se va afişa un meniu şi vei executa clic pe opţiunea Group. Aceasta va avea ca efect gruparea obiectelor grafice şi se vor comporta ca un singur obiect grafic.
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 Reperele din jurul obiectelor grafice îţi vor indica un singur obiect grafic. Dacă vei încerca să le muţi utilizând procedeul „clic and drag” (trage şi plasează) vei observa că obiectele se comportă ca unul singur.
 Pentru a renunţa la gruparea obiectelor grafice şi revenirea la starea iniţială, mai multe obiecte grafice, selectează obiectul grafic grupat, execută clic pe butonul Draw de pe bara de unelte Drawing. Se va afişa un meniu şi vei executa clic pe opţiunea Ungroup. Aceasta va avea ca efect divizarea obiectului grafic grupat în părţile componente.
 .
 Pentru a regrupa obiectele grafice vei executa din nou clic pe butonul Draw şi din meniul care se derulează vei alege opţiunea Regroup.
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 ADĂUGAREA ŞI FORMATAREA CASETELOR DE TEXT
 Casetele de text sunt cele mai importante obiecte pe care le poţi adăuga slide-urilor tale. Aproape fiecare slide pe care-l introduci în prezentarea ta vine însoţit de una sau două casete de text unde poţi introduce textul pe care-l doreşti. În afară de aceste casete de text poţi să introduci şi casetele tale de text dacă execuţi clic pe butonul Text Box de pe bara de unelte Drawing.
 Casetele de text se caracterizează prin:
 Linii întrerupte subţiri de jur împrejurul casetei. Vei putea introduce text în interiorul casetei dacă execuţi clic în interiorul ei.
 Pot fi adăugate pe slide sau şterse din el.
 Ca şi celelalte obiecte grafice pot fi redimensionate.
 Pot fi mutate prin procedeul „clic and drag” (trage şi plasează).
 Pentru a introduce o casetă de text într-un slide urmează paşii:
 Execută clic pe butonul Text Box de pe bara de unelte Drawing. În acest moment indicatorul mouse-ului se transformă în I şi poţi să trasezi caseta de text. Vei ţine apăsat butonul stâng al mouse-ului şi vei trage până când caseta atinge dimensiunea dorită. Eliberează butonul mouse-ului. În interiorul casetei va apare indicatorul de inserare I care pulsează. Acest lucru îţi arată că eşti în modul de editare şi vei trece la editarea textului.
 Este momentul să stabileşti formatul textului pe care-l introduci. De pe bara de formate vei alege fontul şi înălţimea scrisului. Din lista de fonturi Font List
 alegi tipul scrisului executând clic pe săgeata derulantă a listei ascunse de font-uri. Inălţimea scrisului o vei alege din lista ascunsă Font Size executând clic pe săgeata derulantă . Pentru a ieşi din editare execută clic oriunde în afara casetei.
 Notă: Textului introdus în caseta de text poţi să-i aplici alt format şi după ce l-ai editat. Vei selecta textul introdus şi apoi vei alege alt tip de font şi altă înălţime a scrisului.
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 Notă: Pentru a edita text în caseta de text poţi apela şi la meniul rapid care se desfăşoară când execuţi clic pe butonul drept al mouse-ului având caseta selectată. Din meniul care se desfăşoară vei alege opţiunea Edit Text.
 Casetele de text le redimensionezi ca şi pe celelalte obiecte grafice. Selectezi caseta a cărei dimensiuni vrei să le modifici. Poziţionezi cursorul mouse-ului pe unul dintre repere. Când cursorul se transformă într-o săgeată dublă execută clic, ţine butonul mouse-ului apăsat şi trage de margine până când caseta ajunge la dimensiunile dorite. Eliberează cursorul mouse-ului. Linia punctată care apare te ajută să vizualizezi noua dimensiune a casetei.
 Dacă textul pe care-l introduci depăşeşte marginile casetei ai la dispoziţie mai multe metode pentru a-l încadra exact în casetă: fie redimensionezi caseta, fie redimensionezi scrisul, fie selectezi caseta, execuţi clic dreapta şi din meniul rapid care se derulează alege opţiunea Format AutoShape. În caseta de dialog care se deschide execută clic pe tab-ul Text Box şi activează opţiunea Word Wrap text in AutoShape. Textul va fi împărţit pe mai multe rânduri astfel încât să încapă în caseta de text.
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 Dacă doreşti să modifici culoarea de umplere a casetei de text vei executa clic pe săgeata derulantă corespunzătoare butonului Fill Color de pe bara de unelte Drawing. Din caseta care se deschide vei alege noua culoare de umplere sau noul efect de umplere.
 Dacă doreşti să modifici culoarea linei ce înconjoară caseta de text sau dacă nu doreşti linii în jurul ei vei executa clic pe săgeata derulantă corespunzătoare butonului Line Color de pe bara de unelte Drawing. Din caseta care se deschide vei selecta opţiunea care te interesează.
 Dacă doreşti să modifici culoarea font-ului din caseta se text vei executa clic pe săgeata derulantă corespunzătoare butonului Font Color de pe bara de unelte Drawing. Din caseta care se deschide vei selecta opţiunea care te interesează.
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 UTILIZAREA STILOULUI GRAFIC ÎN TIMPUL PREZENTĂRII
 Stiloul grafic îl poţi folosi pentru notiţe de mână în timpul unei prezentări. Cu ajutorul lui vei putea face adnotări, sublinia, înconjura diverse elemente direct pe slide în timp ce prezinţi. Stiloul grafic îţi este pus la dispoziţie în modul de vizualizare Slide Show.
 Pentru a activa stiloul grafic urmează paşii:
 Schimbă modul de vizualizare din Normal View în Slide Show View. Pentru aceasta ai la dispoziţie una din metodele:
 ♦ Execută clic pe butonul Slide Show de pe bara de derulare orizontală;
 ♦ Apasă tasta funcţională F5;
 ♦ Execută clic pe butonul Slide Show de pe bara de meniuri şi din lista care se derulează alege opţiunea View Show.
 In acest mod de vizualizare slide-ul va umple întregul ecran al monitorului. Trecerea de la un slide la altul o vei face fie executând clic pe butonul mouse-ului, fie apăsând tasta <Enter> sau <Spacebar>.
 Activează stiloul grafic executând combinaţia de taste <Ctrl>+<P>. Indicatorul mouse-ului se va transforma din săgeată în stilou . Cu ajutorul lui vei face anumite notări pe slide.
 Notă: Stiloul grafic poţi să-l activezi şi din butonul Slide Show situat în colţul stânga jos. Din meniul care se derulează alege opţiunea Pointer Options şi din submeniul afişat alege Pen.
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 Însemnările pe care le faci cu stiloul grafic apar ca şi cum te-ai fi jucat cu creta pe asfalt. Ceea ce desenezi pe slide cu stiloul grafic nu este definitiv. Ele rămân pe slide atât timp cât rulezi prezentarea sau nu apeşi tasta <E>.
 Dacă doreşti să schimbi culoarea stiloului grafic execută clic pe butonul Slide Show situat în colţul stânga jos. Din meniul care se derulează alege opţiunea Pointer Options. Când execuţi clic pe această opţiune se va deschide un meniu din care vei alege opţiunea Pen Color. Această opţiune îţi va deschide o listă cu toate culorile puse la dispoziţie. Selectează noua culoare executând clic pe ea. Din acel moment stiloul grafic îşi va schimba culoarea.
 Revenirea la indicatorul de tip săgeată o poţi face în două moduri:
 ♦ Execuţi combinaţia de taste <Ctrl>+<A>;
 ♦ Execuţi clic pe butonul Slide Show, din meniul care se desfăşoară alege opţiunea Pointer Options şi din submeniul afişat alege Arrow.
 Notă: Lista de comenzi şi meniuri pusă la dispoziţie de butonul Show View poţi să o activezi şi dacă execuţi clic dreapta oriunde pe slide. Această listă îţi pune la dispoziţie şi comenzi cu ajutorul cărora te poţi deplasa între slide-uri pe parcursul prezentării: comanda Next care face saltul la slide-ul următor, comanda Previous care face saltul la slide-ul anterior, comanda Go te ajută să faci saltul la un anumit slide din prezentare, comanda End Show îţi va închide modul de vizualizarea Slide Show şi vei reveni la modul de vizualizare Normal.
 Butonul Slide Show menu
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 ALEGEREA UNEI SCHEME DE CULORI PENTRU SLIDE-URI
 Această facilitate îţi permite să adaugi culori „vibrante” prezentării tale. Aplicaţia Power Point îţi pune la dispoziţie o schemă de culori. O schemă de culori este alcătuită dintr-un set de opt culori pe care le poţi folosi ca şi culori principale în prezentarea ta. Cu ajutorul unei asemea scheme vei stabili culoarea de fundal, culoarea textului, liniilor, umbrelor precum şi efectele de umplere dintr-o prezentare.
 Aplicaţia Power Point are depuse schemele de culori în templete-urile (şabloanele) pe care se bazează prezentarea. Fiecare template(şablon) conţine mai multe scheme de culori create special pentru a lucra cu acel tip de template.
 Pentru alegerea schemei optime de culori vei urma paşii:
 Execută clic pe butonul Format de pe bara de meniuri şi din lista care se derulează alege opţiunea Slide Color Scheme.
 Se deschide caseta de dialog Color Scheme. Aceasta este alcătuită din două tab-uri. Tab-ul Standard conţine toate schemele de culori puse la dispoziţie pentru template-ul(şablon) pe care se bazează prezentarea ta.Tab-ul Custom îţi permite să schimbi culorile implicite din schema de culori.
 ♦ Tab-ul Standard este tab-ul pe care se deschide caseta de dialog Color Scheme.
 În partea dreaptă a casetei se află cinci butoane care-ţi oferă următoarele opţiuni:
 Apply to All – aplică schema de culori aleasă întregii prezentări, inclusiv Master Slide-ului.
 Apply – aplică schema de culori numai slide-ului sau slider-lor selectate.
 Scheme de culori standard(implicite)
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 Cancel – anulează selecţia.
 Preview- Va aplica temporar schema aleasă prezentării pentru a putea vizualiza cum arată. Modificările vor fi făcute abia după ce execuţi OK.
 ♦ Tab-ul Custom îţi permite să modifici culoarea fundalului, a liniilor şi textului, umbrelor, titlului, etc. În partea stângă a casetei se află lista de culori Scheme Colors. Selectează culoarea care vrei s-o schimbi, apoi execută clic pe butonul Change Color. Dacă doreşti, de exemplu, să schimbi culoarea titlului execută clic pe culoarea corespunzătoare câmpului Title text după care execută clic pe butonul Change color.
 Îin acel moment se deschide caseta de dialog Title Text Color. Şi această casetă
 de dialog are la rândul ei două tab-uri. Tab-ul Standard şi tab-ul Custom. Tot ce ai de făcut în acest moment este alegerea unei noi culori pentru titlu. Când ai ales culoarea execută clic pe butonul OK.
 După ce ai executat OK în caseta Color Scheme în dreptul câmpului Title Color
 va apare noua culoare selectată.
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 Modificarea culorii o vezi în caseta Preview. Execută clic pe butonul Preview
 pentru a aplica temporar noile culori prezentării.
 În partea dreaptă a casetei se află cinci butoane care-ţi oferă următoarele opţiuni:
 Apply to All – aplică schema de culori aleasă întregii prezentări, inclusiv Master Slide-ului.
 Apply – aplică schema de culori numai slide-ului sau slider-lor selectate.
 Cancel – anulează selecţia.
 Preview - Va aplica temporar schema aleasă prezentării pentru a putea vizualiza cum arată. Modificările vor fi făcute abia după ce execuţi OK.
 După ce execuţi clic pe una din opţiunile Apply sau Apply to All caseta de dialog Color Scheme se închide.
 Culoarea font-ului poţi s-o modifici ulterior dacă execuţi clic oriunde pe slide, apoi execuţi clic pe săgeata derulantă a butonului Font Color de pe bara de unelte Drawing. Cele opt culori care se afişează sunt culorile utilizate de schema curentă de culori. Execută clic pe opţiunea More Font Colors şi alege noua culoare de font.
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 Iată pe scurt cele opt culori puse la dispoziţie de schema de culori.
 Culoarea aplicată aferentă Descrierea
 Background Culoarea folosită pentru fundal. De obicei se foloseşte o culoare mai închisă pentru ecran şi o culoare mai deschisă pentru colaje.
 Text & Lines Culoarea aplicată textelor marcate, blocurilor de text şi liniilor desenate pe slide. Este recomandat să foloseşti o culoare cât mai apropiată de culoarea de contrast a fundalului.
 Shadows Culoarea aplicată efectelor de umbră folosite în formatarea textului şi a obiectelor grafice. Este recomandat să aplici o culoare mai închisă.
 Title Text Culoarea aplicată titlurilor corespunzătoare slide-urilor. Este recomandat să foloseşti o culoare care să-l scoată în evidenţă.
 Fills Culoarea de umplere a oricărui obiect grafic creat cu ajutorul barei de unelte Drawing.
 Accent Culoarea aplicată unor obiecte de importanţă mai mică de pe slide(ex.grafice)
 Accent and hiperlink
 Culoarea aplicată hiperlegăturilor de pe slide. In mod obişnuit culoarea alocată este albastră.
 Accent and followed hiperlink
 Culoarea aplicată hiperlegăturilor care au fost accesate.In mod obişnuit culoarea alocată este mov.
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 SCHIMBAREA CULORII DE FUNDAL A SLIDE-ULUI
 Pentru a obţine efecte vizuale care să capteze atenţia auditorilor poţi modifica culoarea de fundal a slide-ului. Dacă în prezentare ai introdus grafice poţi modifica culoarea coloanelor, barelor din grafic precum şi culoarea Chart Area sau/şi Plot Area.
 Dacă vei dori să modifici culoarea de fundal urmează paşii:
 Execută clic pe butonul Format de pe bara de meniuri. Din lista care se derulează alege opţiunea Background.
 Se deschide caseta de dialog Background.
 Execută clic pe săgeata derulantă care-ţi va afişa o listă cu mai multe opţiuni de umplere a fundalului:
 ♦ Color palette color: îţi va umple fundalul cu una din cele opt culori ale schemei de culori curente.
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 ♦ More Colors: îţi va deschide caseta de dialog Colors de unde vei putea alege una dintre sutele de culori puse la dispoziţie de tab-ul Standard şi Custom.
 ♦ Fill Effects: îţi va umple fundalul cu efecte de culori. Ai la dispoziţie patru tipuri de efecte de umplere: gradient, texture, pattern şi picture.
 Tab-ul Gradient: umple fundalul sau obiectele grafice cu gradienţi de culoare care fac trecerea de la o culoare la alta.
 Tab-ul Texture: umple fundalul sau obiectele grafice cu texturi.
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 Tab-ul Pattern: umple fundalul sau obiectele grafice cu diverse modele.
 Tab-ul Picture: umple fundalul sau obiectele grafice cu o imagine sau
 un grafic dintr-un fişier. Acest tab îţi deschide caseta de dialog Select Picture. După ce selectezi numele fişierului acesta va apare în caseta File name. Execută clic pe butonul Insert pentru ca imaginea să devină noul fundal pentru slide.
 După ce-ai ales noua culoare sau noul efect de umplere pentru fundal execută clic pe butonul OK pentru a închide caseta de dialog Color sau caseta de dialog Fill Effects. Odată închisă una din aceste casete de dialog vei reveni în caseta de dialog Background.
 Dacă ai ales un grafic ca fundal este timpul să hotărăşti dacă vrei să-l foloseşti ca fundal şi pentru Master-Slide. Dacă nu doreşti graficul ca fundal pentru Master Slide vei bifa opţiunea Omit background graphics from master.
 Execută clic pe butonul Preview. Aplicaţia Power Point va aplica temporar noul fundal prezentării tale şi o să vezi cum arată prezentarea cu noua setare.
 Execută clic pe butonul Apply to all pentru a aplica noul fundal întregii prezentări.
 Execută clic pe butonul Apply pentru a aplica noul fundal doar pe slide-ul curent sau pe cele selectate.
 Execută clic pe butonul Cancel pentru a anula modificările făcute asupra fundalului..
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 REZUMATUL LECŢIEI 1
 În cursul acestei lecţii ai învăţat următoarele:
 Să inserezi header/footer (antet şi subsol) într-o prezentare apelând la meniul View.
 Să activezi butonul Spelling de pe bara standard pentru verificarea din punct de vedere ortografic a unei prezentări în limba engleză.
 Să introduci o imagine Clip Art într-o prezentare.
 Să redimensionezi şi să muţi o imagine Clip Art introdusă într-o prezentare.
 Să adaugi, să selectezi, să redimensionezi, să muţi, să copiezi şi să ştergi formele grafice introduse cu ajutorul barei de unelte Drawing.
 Să formatezi obiectele grafice.
 Să inserezi şi să formatezi obiecte grafice importate din alte fişiere sau create cu WordArt.
 Să aliniezi şi să grupezi obiecte grafice.
 Să adaugi, să aranjezi şi să formatezi casetele de text introduse într-o prezentare.
 Să utilizezi stiloul grafic în timpul unei prezentări.
 Să alegi alte scheme de culori pentru slide-uri şi să modifici culoarea de umplere a fundalului.
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 ÎNTREBĂRI RECAPITULATIVE
 Întrebări grilă
 Bifează răspunsurile care le consideri corecte. Întrebările pot avea unul, două, trei sau patru răspunsuri corecte.
 Care dintre următoarele propoziţii nu este adevărată ?
 Tasta <Shift> apăsată în timp ce desenezi te ajută să trasezi linii perfect drepte, cercuri şi pătrate.
 Bara de unelte Drawing conţine unelte care te ajută să trasezi linii, săgeţi, să desenezi forme geometrice.
 Textul dintr-o casetă de text nu poate fi formatat.
 Poţi modifica dimensiunule unei casete de text selectând-o şi apoi tragi de unul dintre reperele de redimensionare.
 Care dintre următoarele propoziţii îţi indică o metodă de selectare a mai multor obiecte grafice de pe un slide?
 Execută clic pe butonul Select Object de pe bara standard, execută clic pe obiectele care vrei să le selectezi, apasă tasta <Enter> când ai terminat de făcut selecţia.
 Ţine apăsată tasta <Shift> când selectezi obiectele grafice.
 În aplicaţia Power Point poţi selecta doar un obiect o dată.
 Execută clic pe butonul Arrow de pe bara de unelte Drawing şi înconjoară cu un dreptunghi obiectele grafice pe care vrei să le selectezi.
 Block Arrows, Stars&Banners şi Callouts sunt exemple de:
 Diverse modele de piese Lego.
 Categorii Clip Art pe care le găseşti în galeria Microsoft Clip.
 Categorii Auto Shapes.
 Mai mulţi termeni tehnici pe care nu-i înţeleg.
 Care dintre următoarele propoziţii nu este adevărată ?
 WordArt este un program independent care poate fi folosit de oricare dintre programele Microsoft (Word & Excel).
 WordArt are propria bară de unelte care-ţi permite să schimbi forma, culoarea şi înclinaţia obiectului grafic.
 Poţi schimba culoarea sau textura unui obiect WordArt utilizând bara de unelte WordArt.
 Poţi introduce efecte de animaţie obiectelor WordArt.
 Care dintre următoarele efecte de umplere le poţi folosi pentru a schimba fundalul unui slide?
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 Gradient
 Brightness (Luminozitate)
 Picture
 Texture
 Completaţi
 Pentru a introduce Header/Footer (antet/subsol) într-un slide urmezi paşii:
 Inserarea de imagini ClipArt într-o prezentare se face urmând paşii:
 Schimbarea formei indicatorului mouse-ului din săgeată în stilou grafic pe parcursul unei prezentări se face astfel:
 Exerciţii
 1) Deschide prezentarea „Proiect de curs.ppt”.
 2) Inserează Header şi footer.
 3) Poziţionează-te pe al doilea slide. Cu ajutorul barei Drawing trasează un pătrat şi un cerc.
 4) Schimbă culoarea de umplere a celor două forme grafice alegând 2 gradienţi de culoare.
 5) Grupează-le şi mută-le în diverse locuri pe slide.
 6) Sub cele două forme adaugă un comentariu într-o casetă de text. Aplică diverse fomate textului introdus (schimbă tipul de scris, înălţimea scrisului şi culoarea).

Page 52
                        

52
 7) Pe următorul slide inserează un obiect WordArt. Schimbă-i înclinarea.
 8) Inserează o imagine ClipArt.
 9) Schimbă culoarea de fundal a slide-urilor utilizând ca model de umplere o textură.
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 Lecţia 2
 Obiectivele lecţiei
 Crearea unei prezetări în alb Aplicarea designe template Crearea de tabele din interiorul Power Point Tipărirea prezentării cu opţiuni avansate Speaker notes Tipărirea speaker notes într-un format
 specificat Audience handouts Începerea prezentării de pe orice slide Schimbarea şabloanelor
 În această lecţie vei învăţa să-ţi creezi o prezentare în alb (blank presentation) sau folosind designe template (şabloane de proiectare) şi să creezi tabele în interiorul prezentării tale. Ai să afli cum poţi să creezi speaker notes (notiţele prezentatorului) şi cum le poţi tipări separat, iar apoi vei afla cum se schimbă şabloanele folosite în crearea prezentării. Vei învăţa să creezi şi să tipăreşti colaje pentru auditoriu (audience handouts), pentru o mai bună urmărire a prezentării tale. Odată realizată prezentarea ai posibilitatea să începi derularea ei de pe orice diapozitiv, iar cum se face acest lucru vei afla parcurgând această lecţie.
 CREAREA UNEI PREZENTĂRI
 Primul pas pe care trebuie să-l faci în momentul în care ai decis să creezi o prezentare este să lansezi în lucru aplicaţia Power Point. Pentru aceasta, aşa cum ai învăţat în lecţia 1, execuţi clic pe butonul Start din bara de task-uri, apoi selectezi Programs şi din lista de opţiuni alegi aplicaţia Microsoft Power Point. Se deschide următoarea casetă de dialog:
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 Această casetă îţi permite să creezi o prezentare nouă în trei moduri diferite sau îţi dă posibilitatea să deschizi o prezentare existentă. Când deschizi aplicaţia Power Point aceasta îţi propune crearea unei prezentări:
 - cu ajutorul aplicaţiei AutoContent Wizard;
 - folosind şabloane (Design Template);
 - în alb, pe care o poţi organiza aşa cum doreşti (Blank presentation)
 Selectezi butonul radio care corespunde intereselor tale şi apeşi butonul OK.
 CREAREA UNEI PREZENTĂRI ÎN ALB
 Dacă te-ai decis să creezi o prezentare în alb, fără alt ajutor din partea aplicaţiei Power Point execută clic pe butonul Blank presentation şi apoi pe OK.
 Aşa cum ai văzut şi în lecţia 1 când ai aflat despre Folosirea rutinei AutoContent Wizard, se va deschide o fereastră de dialog New Slide care îţi oferă posibilitatea alegerii tipului de slide pe care îl vei folosi. Logic este că vei alege pentru început slide-ul care este implicit selectat, cel în care vei scrie titlul prezentării. Acest lucru îl faci executând clic pe butonul OK.
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 O altă modalitate de a începe crearea unei prezentări în alb (dacă aplicaţia Power Point este lansată) este să deschizi meniul File şi să selectezi New. Execuţi clic pe eticheta General (dacă nu este selectată implicit) şi execuţi dublu clic pe pictograma Blank Presentation (sau apeşi butonul OK). Apare caseta de dialog New Slide de unde selectezi primul tip de slide, pentru a da numele (titlul) prezentării.
 Indiferent care dintre aceste metode a-i alege, rezultatul va fi afişarea primului slide, cel în care vei introduce titlul prezentării.
 Execuţi clic în dreptunghiul gri unde este mesajul Click to add title sau în zona de editare din partea stângă a ecranului şi introduci titlul prezentării. În momentul în care ai terminat de editat acest titlu, execuţi un clic în zona de editare a subtitlului, în caseta cu mesajul Click to add subtitle. Dacă ai lucrat în zona de editare, după scrierea titlului vei apăsa tasta Enter şi apoi butonul Demote pentru scrierea subtitlului (altfel vei scrie titlul celui de-al doilea slide).
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 Pasul următor este adăugarea unui nou slide, pentru a începe „construirea” prezentării. Din meniul Insert selectezi New Slide..., ceea ce va avea ca efect deschiderea ferestrei New Slide. Dacă îţi este mai uşor poţi apăsa combinaţia de taste Ctrl + M. Aici execuţi clic pe tipul de slide pe care doreşti să-l introduci în prezentare şi apeşi butonul OK. Vei executa clic în zona de titlu a diapozitivului şi-i vei scrie titlul, apoi un clic în zona de text şi vei scrie conţinutul (textul). În funcţie de tipul de diapozitiv pe care l-ai selectat poţi introduce nu numai text, ci şi imagini, grafice, organigrame, poţi scrie pe o coloană, două sau mai multe sau poţi pur şi simplu să alegi inserarea unui slide care nu conţine nimic, este alb.
 După completarea fiecărui slide vei reparcurge secvenţa Insert, New Slide..., scriind de fiecare dată conţinutul lor şi astfel construind de fapt întreaga prezentare.
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 CREAREA UNEI PREZENTĂRI NOI CU UN ŞABLON DE PROIECTARE
 Un şablon este varianta intermediară între un maximum de asistenţă oferit de AutoContent Wizard şi nici un ajutor (Blank Presentation).
 Aplicaţia Power Point oferă două tipuri de şabloane: şabloane de prezentare (oferite de AutoContent Wizard) şi şabloane de proiectare.
 Şabloanele de prezentare conţin formatări şi diapozitive monstră.
 Şabloanele de proiectare conţin doar formatarea, dar nici un diapozitiv.
 Pentru a începe crearea unei prezentări noi utilizând un şablon de proiectare vei urma aceşti paşi:
 Deschizi aplicaţia Power Point;
 Deschizi meniul File şi selectezi New. În fereastra care apare apeşi eticheta Design Templates.
 Alegi din lista de şabloane pe cel care corespunde dorinţei tale (când execuţi clic pe şablon imaginea lui miniaturizată apare în zona Preview).
 Validezi selecţia apăsând butonul OK.
 Se deschide fereastra New Slide în care execuţi clic pe tipul de şablon pe care îl doreşti.
 În continuare procedezi exact ca la crearea unei prezentări în alb (vezi şi Crearea unei prezentări folosind Template din lecţia 1).
 Notă: Dacă ai creat o prezentare şi doreşti să-i schimbi ulterior şablonul de proiectare, urmează paşii: alege meniul Format, apoi selectează Apply Design Template. Din caseta de dialog Apply Design Template execută clic pe numele şablonului, apoi pe butonul Apply. Din această fereastră dacă vrei să accezi la şabloanele de prezentare poţi apăsa butonul Up One Level şi apoi execuţi dublu-clic pe folderul 1033 pentru a afişa lista acestora.
 Nu trebuie să uiţi că salvarea din când în când a prezentării este recomandabilă pentru păstrarea „în siguranţă” a ceea ce ai lucrat, aşa cum ai văzut în lecţia 1 când ai învăţat despre Salvarea unei prezentări.
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 CREAREA DE TABELE ÎNTR-O PREZENTARE POWER POINT
 După cum şti un tabel este o structură în care se pot organiza datele pe rânduri şi coloane. Fiecare intrare dintr-un tabel se numeşte celulă şi este independentă de celelalte intrări.
 Operaţia de creare tabele în aplicaţia Power Point este foarte simplă. Inserezi un nou slide cu ajutorul secvenţei Insert, New Slide şi în fereastra New Slide îl alegi pe cel de tip Tabel (vezi Crearea unei prezentări în alb), apoi apeşi butonul OK. Noul slide are zona
 de editare titlu şi pe cea de editare tabel. Execuţi un dublu clic în zona de creare a tabelului şi se va deschide caseta de dialog Insert Table în care fie editezi, fie foloseşti butoanele de creştere şi descreştere, indicând numărul de coloane şi rînduri pe care doreşti să le aibă tabelul. În momentul în care apeşi butonul OK pe ecran va apare bara cu instrumente Tables And Borders sau cursorul va
 avea forma unui creion, tabelul fiind selectat (înconjurat de un chenar gri).
 Dacă nu ai activă bara cu instrumente Tables And Borders apasă meniul View, apoi Toolbars şi selectează Tables And Borders. Pe ecran ai acum bara cu instrumente.
 Notă: O altă metodă de a adăuga un tabel este utilizarea comenzii Table din meniul Insert. Aceasta o vei folosi dacă ai inserat un slide alb şi apoi doreşti ca în el să inserezi un tabel. Vei indica numărul de coloane şi rânduri şi vei continua
 Chenarele care înconjoară celulele pot fi afişate sau ascunse astfel: execuţi clic pe săgeata de derulare din dreptul butonului Borders de pe bara de instrumente şi apoi pe butonul No Borders de pe paleta afişată.
 chenare afişate chenare neafişate (No Borders)
 Deplasarea în interiorul tabelului o poţi face cu tasta Tab (pentru trecerea dintr-o celulă în cealaltă, spre dreapta) sau cu combinaţia de taste Shift + Tab pentru deplasare la o celulă anterioară, spre stânga. Desigur poţi executa un clic cu mouse-ul în celula în care doreşti să editezi, dacă preferi să lucrezi cu mouse-ul.
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 În cazul în care ai greşit în timpul editării apeşi tasta Backspace pentru a şterge caracterul din stânga punctului de inserare sau tasta Delete pentru a şterge caracterul din dreapta lui.
 Trecerea la un nou paragraf în celulă o realizezi apăsând tasta Enter.
 O altă metodă de inserare rapidă a unui tabel într-un slide este folosirea meniului Insert şi selectarea comenzii Table sau apăsarea butonului Table de pe bara de instrumente. În acest caz vei menţine apăsat butonul stâng al mouse-ului şi vei „trage” în jos şi la dreapta, indicând astfel numărul de rînduri şi de coloane pe care doreşti să le conţină tabelul tău. Eliberarea butonului mouse-ului va avea ca efect inserarea tabelului.
 INSERAREA ŞI ELIMINAREA COLOANELOR ŞI RÂNDURILOR
 Primul lucru pe care trebuie să-l faci atunci când doreşti să inserezi sau să ştergi rînduri/coloane este să selectezi tabelul. Acest lucru îl realizezi rapid executând un clic în interiorul tabelului. Vei observa că tabelul este acum înconjurat de un chenar colorat cu altă nuanţă (gri) şi cu marcaje.
 INSERAREA UNEI COLOANE
 Poziţionezi cursorul (punctul de inserare) într-o celulă din coloana lîngă care vei face inserarea.
 Execuţi un clic pe butonul Table de pe bara cu instrumente Tables and Borders. Din meniul care este afişat execuţi clic pe Select Column. Vei
 observa că întreaga coloană este colorată cu o altă culoare, este marcată.
 Execuţi din nou clic pe butonul Table de pe bara cu instrumente Tables and Borders. Alegi una din cele două opţiuni de inserare de coloane: Insert Columns to the Left – inserarea noii coloane se face la stânga coloanei selectate-, sau Insert Columns to the Right - inserarea noii coloane se face la dreapta coloanei selectate.
 INSERAREA UNUI RÂND
 Poziţionezi cursorul (punctul de inserare) într-o celulă de pe rândul deasupra sau dedesubtul căruia vrei să faci inserarea.
 Execuţi un clic pe butonul Table de pe bara cu instrumente Tables and Borders. Din meniul care este afişat execuţi clic pe Select Row. Vei observa că rândul este colorat cu o altă culoare, este marcat.
 Execuţi din nou clic pe butonul Table de pe bara cu instrumente Tables and Borders. Alegi una din cele două opţiuni de inserare de rânduri: Insert Rows Abowe – inserarea noului rând se va face deasupra rândului selectat-, sau Insert Rows Below - inserarea noului rând se va face sub rândul selectat.
 Notă: Dacă selectezi mai multe coloane sau mai multe rânduri şi apoi dai comanda de inserare, vor fi inserate atâtea coloane/rânduri câte selectasei anterior.
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 ŞTERGEREA UNEI COLOANE SAU A UNUI RÂND
 Eliminarea unei coloane sau a unui rând este o operaţie extrem de simplă. Execuţi următorii paşi:
 Plasezi cursorul (punctul de inserare) într-o celulă de pe coloana sau rândul care trebuie ştearsă.
 Execuţi clic pe butonul Table de pe bara cu instrumente Tables and Borders şi apoi pe Select Column sau pe Select Row.
 Execuţi clic pe butonul Table şi apoi pe Delete Columns sau Delete Rows.
 MODIFICAREA LĂŢIMII COLOANELOR ŞI ÎNĂLŢIMEA RÂNDURILOR
 O metodă rapidă de modificare a lăţimii coloanelor sau a înălţimii rândurilor este redimensionarea cu ajutorul mouse-ului. Astfel, pentru a modifica lăţimea coloanei procedezi astfel:
 Plasezi indicatorul mouse-ului pe chenarul din dreapta coloanei a cărei lăţime trebuie modificată. Acesta va lua forma unei perechi de săgeţi verticale cu două vârfuri orientate dreapta/stânga.
 Ţii apăsat butonul stâng al mouse-ului şi deplasezi prin tragere chenarul (linia) coloanei până obţii lăţimea dorită.
 Eliberezi butonul mouse-ului şi ai încheiat operaţia de redimensionare.
 Pentru a modifica înălţimea unui rând plasezi indicatorul mouse-ului pe linia care-l desparte de rândul următor şi procedezi identic ca la coloană.
 UNIREA ŞI DIVIZAREA CELULELOR
 Atunci când doreşti să creezi un cap de tabel poţi să uneşti mai multe celule de pe un rând într-una singură, pentru a scrie un antet pentru tabel, astfel:
 Selectezi o celulă din primul rând al tabelului;
 Execuţi clic pe butonul Table de pe bara cu instrumente Tables and Borders şi apoi pe Select Row din meniul butonului;
 Execuţi clic pe butonul Merge Cells de pe bara cu instrumente.
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 După cum observi în imaginea următoare, celulele s-au unit, astfel că acum poţi scrie antetul tabelului pe toată lungimea lui, dându-i un aspect plăcut. Butonul Merge Cells nu mai este activ, până când vei face altă selecţie de celule.
 Folosind butoanele de aliniere text vei putea să plasezi titlul tabelului în mai multe poziţii: sus, centrat sau jos faţă de marginile celulei.
 Dacă mai târziu îţi dai seama că nu vrei ca aceste celule să fie unite poţi selecta această celulă şi să apeşi butonul Split Cell de pe bara cu instrumente Tables And Borders.Efectul va fi redivizarea celulei.
 FORMATAREA UNUI TABEL
 Datele dintr-un tabel se formatează ca şi textul, aşa cum ai învăţat în lecţia 2 „Formatarea textului”. Poţi formata şi structura tabelul prin adăugare de chenare şi a unei culori de fond cu altă nuanţă decât cea aleasă iniţial.
 Pentru aceasta execuţi clic pe meniul Format şi apoi pe Table sau execuţi clic dreapta şi din meniul rapid selectezi Borders And Fill. Se deschide o casetă de dialog Format Table care are trei butoane (tab-uri).
 1. Butonul Borders îţi permite să alegi stilul (tipul) de linie pe care doreşti să o foloseşti la trasarea chenarului (Style), culoarea ei (Color) şi grosimea (Width). Pentru a aplica rapid chenarul execuţi clic pe butoanele din partea dreaptă a acestei ferestre sau chiar în zona de previzualizare. Închei apăsând butonul OK.
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 2. Butonul Fill îţi permite să alegi o culoare pentru fundalul celulei sau celulelor selectate. Dacă bifezi caseta Fill color: , deci doreşti culoare pentru fundal, vei observa că se activează şi butonul Preview, cel ce-ţi va permite previzualizarea selecţiilor pe care le vei face în continuare.
 Atunci când apeşi butonul de derulare din dreapta casetei ce conţine culoarea implicită de fundal, se va afişa o paletă cu câteva culori de bază pentru fundal şi cu trei opţiuni : More Colors...,Fill Effects... şi Background. Acestea îţi permit selecţii
 avansate atât pentru culoarea cât şi pentru textura fundalului.
 2.1 Dacă execuţi clic pe opţiunea More Colors... se va deschide caseta de dialog Colors care are două tab-uri (butoane).
 ♦ Tab-ul Standard îţi va permite selectarea culorii de fundal dintr-o paletă variată de culori şi nuanţe.Dacă poziţionezi mouse-ul pe una din aceste culori, în caseta de previzualizare din colţul dreapta-jos vei vedea în partea superioară noua culoare (New), iar în partea de jos culoarea curentă, care va fi înlocuită (Current).
 ♦ Butonul Custom îţi permite să modifici luminozitatea , intensitatea culorii şi gradul de saturaţie. Când se deschide această fereastră, în partea de sus a casetei Colors se află un fir reticular pe jumătate ascuns. Plasează indicatorul mouse-ului pe el, ţine apăsat butonul stâng al mouse-ului şi tragel undeva în casetă. Când ai eliberat butonul mouse-ului, aplicaţia Power Point îţi afişează în caseta de previzualizare New din colţul dreapta-jos culoarea pe care ai selectat-o (cea pe care ai plasat firul reticular), îi analizează tonalitatea (Hue), saturaţia

Page 63
                        

63
 (Sat), luminozitatea (Lum), precum şi procentul de roşu (Red), verde (Green) şi albastru (Blue). Tonalitatea se schimbă prin deplasarea firului reticular în direcţie orizontală, iar saturaţia se modifică prin deplasarea lui pe verticală. Schimbări ale acestor valori se vor înregistra şi dacă vei deplasa săgeata din dreptul scalei verticale pentru luminozitate.
 După ce ai stabilit totul, apeşi butonul OK şi revii în caseta Fill.
 2.2 Dacă doreşti să aplici efecte vizuale culorii de fundal vei executa clic pe Fill Effects... şi din caseta Fill Effects care se deschide ai posibilitatea să alegi tipul de textură, câte culori să foloseşti, orientarea umbrelor fundalului, etc. După cum observi există patru butoane (tab-uri): Gradient, Texture, Pattern, Picture.
 ♦ Butonul Gradient este cel care îţi
 permite selectarea culorii de umplere. În secţiunea Colors ai posibilitatea să optezi pentru folosirea unei singure culori în degrade (butonul radio One color), a combinaţiei de două culori (butonul radio Two colors) sau a combinaţiei de culori propuse de aplicaţia Power Point (butonul Preset). Dacă ai decis să foloseşti o singură culoare aplicaţia o va prezenta în caseta Color 1:, iar imediat sub ea îţi va pune la dispoziţie o bandă de reglare a luminozităţii. Dacă ai decis să foloseşti două culori, acestea vor fi prezentate una sub cealaltă, ca în figura alăturată. Butonul Preset îţi va oferi în caseta Preset colors o listă de combinaţii de culori, grupate pe diferite teme.
 Secţiunea Shading styles îţi permite să alegi modul în care să se realizeze umplerea celulelor selectate cu culorile alese în secţiunea superioară: pe orizontală (Horizontal), pe verticală (Vertical), ascendent pe diagonală (Diagonal up), descendent pe diagonală (Diagonal down), pornind dintr-un colţ (From corner) sau pornind din centru (From centre). Oricare buton radio bifezi la un moment dat rezultatul îl vezi în caseta Variants din dreapta lor. Caseta Sample din colţul din dreapta-jos al casetei îţi oferă zona de previzualizare generală, a tuturor selecţiilor şi modificărilor pe care le faci la un moment-dat.
 ♦ Butonul Texture îţi dă posibilitatea ca în loc de culori să foloseşti modele de texturi pentru a umple zona selectată din tabel sau tot tabelul. Orice selecţie faci, în caseta Sample din colţul dreapta-jos vezi rezultatul. În momentul când execuţi un clic pe o casetă cu un anumit model, în partea de jos vei vedea numele acestuia. În această fereastră ai la dispoziţie butonul Other Texture... care, apăsat, deschide o altă fereastră cu modele noi de texturi.
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 ♦ Butonul Pattern îţi permite să foloseşti mai multe modele de motive geometrice şi haşururi pentru umplerea ca fundal a tabelului sau selecţiei din tabel. Sub zona cu modele ai afişat numele fiecărui model, iar dedesubt ai două casete cu palete de culori pe care le poţi folosi pentru realizarea lui: caseta Foreground îţi permite să alegi culoarea pentru linia (sau motivul geometric) aflată în prim-planul modelului, iar în caseta Backgroung poţi stabili culoarea de fundal.
 În caseta Sample vizualizezi efectul selecţiilor tale.
 ♦ Butonul Picture este cel care îţi permite să foloseşti pentru tabelul tău ca fundal o imagine pe care o ai salvată într-un fişier. Apeşi butonul Select Picture... şi se deschide fereastra de dialog Select Picture. Localizezi fişierul (caseta Look in: se deschide implicit în folderul My Picture, dar în dreapta există un buton care te ajută să te deplasezi şi să localizezi un alt folder), îl selectezi cu un clic, priveşti zona de previzualizare din partea dreaptă a acestei ferestre şi, dacă eşti mulţumit de imaginea aleasă, apeşi butonul Insert. În acest fel imaginea selectată devine fundal al celulei sau tabelului selectat de tine.
 Aşa cum ai văzut şi în alte ferestre şi în aceasta în partea stângă există o bară care conţine butoane care te ghidează rapid spre zone mai des utilizate de tine (My Documents, Desktop,etc), iar în partea dreaptă (deasupra zonei de previzualizare) o serie de butoane. Despre acestea ai învăţat în lecţia 5, Inserarea şi formatarea imaginilor).
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 2.3 Dacă execuţi clic pe opţiunea Background... din tab-ul Fill vei stabili culoarea fundalului celulei selectate sau a tabelului.
 3. Butonul Text Box îţi permite să aliniezi textul din celulă (caseta Text alignment), să stabileşti poziţia scrisului faţă de marginile celulei (secţiunea Internal margin) sau să schimbi orientarea textului cu 900 faţă de orizontală (dacă bifezi caseta Rotate text within cell by 90 degrees). Textul dintr-o celulă poate fi aliniat în partea de sus (Top), în centru (Middle), în partea de jos (Bottom), sau poate fi centrat sus, jos sau la mijlocul celulei. Toate aceste opţiuni le vezi în momentul în care apeşi butonul din dreapta al casetei Text alignment. Pentru a vedea efectul selecţiilor poţi apăsa butonul Preview.
 Când ai selectat tot ce trebuie, apeşi butonul OK.
 Formatarea caracterelor cu care ai editat tabelul o poţi face cu ajutorul meniului Format, de unde selectezi Font sau cu ajutorul butoanelor aflate pe bara de formatare a aplicaţiei Power Point.
 MUTAREA, DIMENSIONAREA ŞI COPIEREA TABELELOR
 Poţi foarte uşor să muţi intrările dintr-un rînd, dintr-o coloană sau dintr-o celulă astfel: le selectezi şi le tragi în poziţia dorită. Dacă vrei doar să le copiezi, după selecţie trebuie să ţii apăsată tasta Ctrl şi apoi să le tragi la noua destinaţie. Dacă vrei să muţi sau să copiezi mai multe rânduri, coloane sau celule va trebui mai întâi să le selectezi pe toate şi abia apoi să execuţi tragerea cu mouse-ul în noua poziţie. Poţi folosi şi comenzile Cut, Copy şi Paste din meniul Edit sau din meniul contextul activat cu un clic executat pe butonul din dreapta al mouse-ului.
 Schimbarea poziţiei unui tabel este simplă. Selectezi tabelul cu un clic pe mouse şi apoi, folosind tastele cu săgeţi de pe tastatură, îl deplasezi stânga, dreapta, sus sau jos.
 Schimbarea dimensiunilor tabelului o realizezi la fel de uşor. Plasezi cursorul mouse-ului pe unul din marcajele aflate pe chenarul tabelului, ţii apăsat butonul stâng al mouse-ului şi tragi păna la dimensiunea dorită. Dacă vei trage de un marcaj dintr-un colţ vei modifica proporţional înalţimea şi lăţimea tabelului.
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 TIPĂRIREA UNEI PREZENTĂRI ÎNTR-O VARIETATE DE FORME
 În lecţia 2 ai aflat cum se face Tipărirea unei prezentări rapid, într-un singur exemplar. Dar tipărirea se poate face şi cu opţiuni mai avansate, despre care vei afla în această lecţie.
 Prezentarea ta poate conţine mai multe sau mai puţine slide-uri, în funcţie de tema pe care o tratezi. Dacă doreşti să realizezi mici broşuri cu conţinutul prezentării execuţi următorii paşi:
 1. Poziţionezi cursorul pe primul diapozitiv al lucrării.
 2. Din meniul File selectezi comanda Print (echivalentă este apăsarea combinaţiei de taste Ctrl+P). Pe ecran se deschide caseta de dialog Print.
 3. Prima secţiune Printer îţi permite să alegi numele imprimantei pe care urmează să faci tipărirea. În caseta Name apare numele imprimantei curent selectate. Dacă doreşti să
 utilizezi o altă imprimantă, deschide lista derulantă Name şi selecteaz-o cu un clic de mouse pe cea dorită. Apăsând butonul Properties ai posibilitatea să-i selectezi acesteia diferite opţiuni, cum ar fi dimensiunea hârtiei, tava de alimentare cu hârtie, calitatea imaginilor. Caseta Print to file (tipărire în fişier) o vei bifa dacă doreşti ca rezultatul să fie trimis într-un fişier, nu la imprimantă. Foloseşti această facilitate atunci când la calculatorul tău nu este conectată o imprimantă. Muţi fişierul astfel obţinut pe un alt calculator la care este legată o imprimantă şi – chiar dacă pe acela nu este instalată aplicaţia Power Point – faci listarea prezentării.
 4. Secţiunea Print Range conţine mai multe butoane radio pe care le poţi selecta, în funcţie de ce anume doreşti să listezi. Astfel selectând butonul All alegi listarea întregii prezentări, a tuturor diapozitivelor. Selectarea butonului Current slide va avea ca efect tipărirea slide-ului afişat în mod curent, pe care este poziţionat cursorul. Butonul Selection îl vei activa în momentul în care ai selectat în prealabil o anumită parte din prezentare care să fie listată. Dacă din diferite motive vrei să listezi doar anumite slide-uri bifezi butonul Slides şi în caseta de editare introduci numerele slide-urilor pe care le vei lista. Dacă vei lista numere dispersate de slide-uri, le vei scrie cu virgulă între ele (exemplu 2,5,18), iar dacă specifici un domeniu întreg de diapozitive, vei scrie numărul primului slide, o cratimă şi numărul ultimului slide (exemplu 9-13).
 5. În partea dreaptă a casetei Print What apeşi butonul de derulare şi din lista de opţiuni poţi alege să tipăreşti diapozitive (Slides), rezumate pentru auditoriu (Handouts), însemnări (Notes) sau structuri (Outline View). Poţi alege 2,3,sau 6 slide-uri pe pagină, în funcţie de cât de mare doreşti să fie listată prezentarea. Ai posibilitatea să stabileşti ordinea de apariţie a slide-urilor, pe orizontală sau pe verticală.
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 6. Aşa cum la vizualizare aveai posibilitatea „schimbării” culorii în alb şi negru, şi la tipărire ai posibilitatea alegerii tipăririi în nuanţe de gri (Greyscale) sau de alb şi negru (Pure black and white).
 7. Caseta Scale to Fit Paper (Scalare la dimensiunile hârtiei) o vei bifa atunci când diapozitivul (sau ceea ce tipăreşti) este prea mare pentru a încăpea în pagină. Sistemul va „redimensiona” totul pentru a se încadra bine pe tipul de hârtie pe care l-ai ales.
 8. Caseta Frame slides (Diapozitive cu ramă) o bifezi atunci când doreşti să tipăreşti un chenar în jurul slide-urilor
 9. Caseta Print Hidden Slides (Tipărire diapozitive ascunse) o bifezi doar dacă ai diapozitive ascunse pe care doreşti să le listezi. Dacă prezentarea ta nu conţine astfel de diapozitive, caseta aceasta nu este disponibilă
 10. Caseta Include Animations (Inclusiv animaţie) o bifezi atunci când în prezentare ai elemente de animaţie. Power Point va face tot ce poate ca să aproximeze aceste elemente într-o formă statică.
 11. Secţiunea Copies este locul în care specifici numărul de copii pe care doreşti să-l imprimi şi (în cazul în care acesta este mai mare de unu) modul de imprimare: toate paginile cu numărul unu urmate de toate care au numărul doi, etc. sau un set întreg al prezentării urmat de un alt set întreg,etc (în acest caz trebuie să ai bifă în căsuţa Collate).
 Cu toţi aceşti parametri stabiliţi nu-ţi rămâne decât să apeşi butonul OK şi listarea la imprimantă va începe.
 ÎNSEMNĂRILE PREZENTATORULUI (SPEAKER NOTES)
 Pe parcursul creării prezentării poţi adăuga şi însemnări pe care să le foloseşti în timpul expunerii tale. Dacă ai diapozitivul afişat în modul de afişare normal sau rezumat poţi executa un clic cu mouse-ul în secţiunea Click To Add Notes şi acolo poţi edita textul referitor la diapozitiv sau ceea ce vrei să prezinţi auditorului tău în acest punct al prezentării. Dacă ai diapozitivul afişat în modul de vizualizare
 Slide vei observa că panoul Notes a fost „minimizat”, nu este afişat. Pentru a redeschide panoul Slide plasează vârful cursorului pe linia de divizare care se află la baza panoului
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 (cursorul îşi schimbă forma, arată ca o săgeată cu două vârfuri), ţine apăsat butonul stâng al mouse-ului şi trage în sus, până la obţinerea dimensiunii dorite pentru acest panou.
 O altă modalitate de a afişa panoul pentru notiţe este selectarea meniului View şi alegerea Notes Page. Ca urmare a acestei acţiuni va fi afişat panoul Notes.
 În panoul Notes ai posibilitatea să editezi text, dar şi să adaugi imagini sau obiecte pe care le creezi cu ajutorul barei Drawing. Acestea nu sunt afişate decât dacă lucrezi în modul de afişare Notes Page View sau dacă îţi tipăreşti prezentarea.
 Trebuie să ştii că ai posibilitatea ca auditoriul tău să vadă aceste însemnări, dar numai dacă îţi salvezi prezentarea în format Web.
 NOTIŢE CU AJUTORUL MEETING MINDER
 În timp ce rulezi prezentarea poţi lua notiţe folosind Meeting Minder. Acesta îţi permite să iei rapid notiţe, să generezi acţiuni legate de discuţiile purtate sau să asculţi comentarii făcute în timpul prezentării. Cum procedezi? În timpul derulării prezentării execuţi clic pe butonul drept al mouse-ului oriunde pe ecran. Apare meniul Slide Show. Aici execuţi clic pe Meeting Minder. Se deschide caseta Meeting Minder care are două butoane (tab-uri).
 Butonul Meeting Minder are o casetă de dialog care îţi permite să introduci text (notiţe).
 Butonul Action Items îţi permite introducerea unui articol de acţiune. În caseta Description introduci o descriere, iar în caseta Assigned To numele persoanei care se va ocupa de acest articol. Apeşi butonul Add pentru a adăuga articolul la lista din pagina Action Items.
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 Dacă
 doreşti să programezi rapid o
 şedinţă, utilizând Outlook,
 execuţi clic pe
 butonul Schedule din caseta
 Meeting Minder. Se va deschide o casetă de dialog Outlook Meeting în care vei putea stabili toate detaliile şedinţei.
 După ce ai completat aceste două ferestre nu rămâne decât să apeşi butonul OK.
 TIPĂRIREA SPEAKER NOTES
 Pentru a tipări însemnările prezentatorului trebuie să urmezi paşii:
 Selectezi meniul File;
 Alegi comanda Print;
 În secţiunea Print What bifezi caseta Notes Pages;
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 Completezi (eventual) celelalte casete necesare tipăririi;
 Închei apăsând butonul OK.
 COLAJELE PENTRU AUDITORIU
 Colajele pentru auditoriu (audience handouts) îţi dau posibilitatea să „arăţi” mai multe miniaturi de slide-uri pe o singură coală de hârtie, practic să faci o listare a prezentării tale la scară foarte redusă. Persoanele din auditoriu pot face ulterior referinţă la un slide sau altul folosind aceste miniaturi, având posibilitatea precizării numărului sau conţinutului slide-ului la care fac referire, fără a crea confuzii. Pentru realizarea acestor colaje urmează paşii:
 În meniul View selectează Master.
 Din submeniul apărut selectează Handout Master.
 Adaugă articolele pe care le doreşti – text, antet şi subsol de pagină care să conţină data şi ora, numărul paginii sau altceva, ce doreşti -.
 Apasă butonul Close de pe bara Master.
 În meniul File execută un clic pe Print.
 În caseta Slides per page execută clic pe numărul de slide-uri care să apară pe colaj.
 Dacă ai optat pentru patru, şase sau nouă slide-uri pe pagină execută un clic alegând Horizontal sau Vertical pentru a stabili ordinea în care să apară acestea pe pagină.
 Închei apăsând butonul OK.
 Orientarea hârtiei pe care se va face listarea o poţi stabili şi cu ajutorul opţiunii Page Setup din meniul File. Dacă ai parcurs aceşti paşi pe ecran s-a deschis fereastra Page Setup care îţi permite – în secţiunea Notes, handouts & outline – să alegi orintarea hârtiei: Portrait (pe vericală) sau Landscape (pe orizontală).
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 Notă: Chiar dacă respectivele slide-uri conţin alte elemente, cum ar fi speaker notes, acestea nu vor apare pe colaje, în momentul listării.
 ÎNCEPEREA PREZENTĂRII DE PE ORICE SLIDE
 Atunci când vrei să vizualizezi o prezentare de diapozitive pe ecran apelezi la meniul Slide Show, comanda View Show. Aceasta îţi facilitează derularea de la început până la sfârşit a prezentării. Acelaşi lucru îl poţi face folosind tasta F5 sau executând un clic pe butonul Slide Show aflat în colţul din stânga-jos al ferestrei prezentării. Pe ecran apare primul diapozitiv şi prezentarea a început.
 Pentru a afişa diapozitivul următor execuţi un clic pe butonul stâng al mouse-ului sau apeşi tasta Page Down. Poţi să foloseşti şi tastele cu săgeată la dreapta sau săgeată în jos.
 Afişarea slide-ului precedent o realizezi apăsând tasta Page Up sau folosind tasta cu săgeata în sus sau tasta cu săgeata la stânga.
 Este posibil însă să doreşti să începi de la un anumit diapozitiv sau, în timpul prezentării cu auditoriu, să ţi se ceară să revii la un anumit diapozitiv. Cum poţi face acest salt rapid la un anumit slide? Fiind în modul de vizualizare Slide Show execută clic-dreapta oriunde pe ecran. Va apare meniul Slide Show. De aici alege Go şi se deschide un submeniu care are active două opţiuni: Slide Navigator şi By Title.
 Selectarea opţiunii Slide Navigator are ca efect deschiderea casetei de dialog Slide Navigator. În secţiunea Slide titles execuţi clic pe numărul (titlul) slide-ului la care vrei să faci deplasarea şi apeşi butonul Go To. Pe ecran vei vedea acum conţinutul diapozitivului selectat.
 Acesta este un mod de deplasare rapidă la un anumit slide.
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 Dacă selectezi opţiunea By Title vei vedea că se deschide o listă cu numărul şi titlul tuturor slide-urilor din prezentare, astfel încât poţi executa un clic pe cel dorit şi pe ecran îţi va fi afişat acesta.
 SCHIMBAREA ŞABLOANELOR
 Să presupunem că, după ce ai creat prezentarea sau ai creat o parte din ea, realizezi că pentru tema aleasă s-ar fi potrivit mai mult un alt şablon. Nu este nici o problemă! Schimbarea şablonului de machetare este foarte simplă, nu necesită multă muncă. Urmează paşii:
 Selectează meniul Format.
 Alege Apply Design Template... pentru a afişa următoarea casetă de dialog (cea din dreapta):
 Selectează din listă (imaginea stânga-sus) tipul de şablon pe care doreşti să-l aplici prezentării tale. Foloseşte caseta de previzualizare din partea dreaptă a ferestrei pentru a vedea cum arată fiecare şablon pe care execuţi clic, iar când te-ai hotărât asupra noului şablon execută clic pe butonul Apply. Schimbarea se produce instantaneu, în toată prezentarea.
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 Un alt procedeu de activare a comenzii Apply Design Template... este executarea unui clic direct pe fundalul oricărui diapozitiv. La apariţia casetei Apply Design Template alege din listă şablonul dorit şi execută dublu clic pe numele lui. Se aplică imedial noul şablon prezentării tale.
 Notă: Ai posibilitatea să schimbi aspectul prezentării nu numai schimbând şablonul ei, ci şi schimbând formatarea textului, aşa cum ai învăţat în lecţia 2 din cursul I.
 REZUMATUL LECŢIEI 2
 În această lecţie ai învăţat cum să creezi o prezentare în alb sau cum să te foloseşti de şabloanele de proiectare pentru construirea unei prezentări. Crearea de tabele în Power Point va fi de acum un lucru simplu, ca şi formatarea, copierea sau mutarea lor. Ai învăţat să tipăreşti diapozitive, structuri şi însemnări şi cum să configurezi opţiunile pentru a realiza o tipărire avansată, a uneia sau mai multor exemplare din lucrarea ta.
 Crearea de notiţe şi realizarea colajelor sunt alte lucruri noi cu care te-ai familiarizat în această lecţie.
 Şi dacă ai aflat cum să realizezi prezentarea, acum ştii şi cum să o prezinţi auditoriului începând din orice punct al ei, de pe orice slide.
 Schimbarea şabloanelor folosite la realizarea prezentării reprezintă abilitatea cea mai nouă căpătată de tine după parcurgerea acestei lecţii, ceea ce îţi va permite intervenţii „profesioniste” asupra oricărei lucrări anterior create.
 ÎNTREBĂRI RECAPITULATIVE
 Întrebări grilă
 Bifează care consideri că este răspunsul corect. Întrebările pot avea unul, două sau trei răspunsuri corecte. În cazul în care răspunsul corect nu se găseşte printre cele trei răspunsuri, bifează căsuţa „Altul”.
 Cum se crează o prezentare în alb?
 START => PROGRAMS => POWER POINT => Blank presentation
 START => PROGRAMS => POWER POINT => Design Template
 START => PROGRAMS => POWER POINT => AutoContent Wizard
 START => PROGRAMS => New Office Document
 Un şablon de proiectare conţine:

Page 74
                        

74
 formatări şi diapozitive monstră
 doar formatarea, dar nici un diapozitiv
 diapozitive neformatate
 Altul
 Inserarea de tabele se poate face urmând secvenţa:
 View, apoi Toolbars şi selectezi Tables And Borders
 Insert, New Slide, selectezi Table şi apeşi butonul OK
 Insert, New Slide, selectezi Blank şi apeşi Table
 Insert, apoi Table, specifici numărul de coloane şi linii şi apeşi butonul OK

Page 75
                        

75
 Cum se face tipărirea unei prezentări în alb şi negru?
 View, Black and White şi se apasă butonul de pe bara cu instrumente
 File, Print şi apeşi butonul OK
 File, Print, selectezi Pure black and white şi apeşi butonul OK
 File, Print, selectezi Greyscale şi apeşi butonul OK
 Ce reprezintă speaker notes?
 Notiţe pe care le iau persoanele care urmăresc prezentarea
 Note tipărite de autorul prezentării, distribuite împreună cu colajele
 Însemnările autorului prezentării
 Note obţinute de vorbitor pentru modul în care a alcătuit şi prezentat lucrarea în Power Point
 Cum se pot realiza şi prezenta colajele auditoriului?
 Din meniul View se selectează Handout Master; se execută clic pe butonul
 Din meniul View se selectează Master, apoi Handout Master; se introduc articolele şi se trece la tipărirea lor selectând meniul File şi executând clic pe Print.
 Din meniul File selectezi Page Setup. Din fereastra care se deschide bifezi Notes, handouts & outline. Apeşi butonul OK. Introduci articolele şi apoi dai comanda de listare.
 Altul
 Completează
 Dacă ai inserat un tabel cu cinci coloane şi două rânduri, ai posibilitatea ştergerii ulterioare a două coloane? Ce secvenţă parcurgi?
 Unirea celulelor dintr-un tabel se realizează astfel:
 La ce se referă „formatarea” unui tabel?
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 Exerciţii:
 1. Inserează un tabel pe un slide alb, care să aibă patru coloane şi trei rânduri.
 2. Uneşte celulele de pe primul rând şi introdu titlul tabelului :”Centralizator”.
 3. Pe rândul al doilea introdu în fiecare coloană titlurile: Nume, Prenume, Notă, Calificativ. Centrează aceste titluri şi colorează-le atât scrisul cât şi fundalul.
 4. Pe al treilea rând introdu numele şi prenumele tău, în coloana „Notă” introdu valoarea 9,87 iar în ultima coloană scrie „admis”.
 5. Inserează alte două rânduri.
 6. Completează-le pe fiecare cu numele a doi colegi din grupă, atribuindu-le unuia nota 6,75 şi calificativul „respins”, celuilalt nota 9,04 şi calificativul „admis”.
 7. Mută spre stânga tabelul.
 8. Schimbă tipul şi grosimea liniei care înconjoară tabelul.
 9. Copiază acest tabel în următorul slide.
 10. Schimbă şablonul folosit cu unul nou, diferit.
 11. Salvează totul cu numele „Creare tabele” în folderul de lucru.
 12. Începe prezentarea din slide-ul al doilea.
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 LECŢIA 3
 Obiectivele lecţiei
 Inserarea de hyperlink-uri Ascunderea slide-urilor create Vizualizarea unei prezentări pe Web Publicarea unei prezentări pe Web Overhead transpariencies
 Pe parcursul acestei lecţii vei învăţa cum poţi să inserezi într-o prezentare de slide-uri un hyperlink sau mai multe, cum poţi să ascunzi dacă nu doreşti să apară în prezentarea ta anumite slide-uri. Vei şti de asemenea la sfârşitul acestei lecţii cum trebuie să procedezi pentru a publica o prezentare creată de tine pe Web şi cum poţi să vizualizezi o asemenea prezentare. Ai să ştii că prezentările în Microsoft PowerPoint pot să fie făcute şi pe foi transparente folosind un retroproiector.
 INSERAREA DE HYPERLINK-URI
 Poţi insera un hyperlink într-o prezentare în orice moment şi în orice poziţie. Un hyperlink este o legatură creată de tine către un fişier existent pe hard disk, către o adresă de Internet sau către un alt slide din prezentarea creată de tine.
 Un hyperlink poate să fie asociat unui buton sau poate să fie asociat unui text sau unei imagini.
 ADĂUGAREA UNUI HYPERLINK LA UN BUTON SAU O IMAGINE
 Următorii paşi îţi arată cum poţi să ataşezi un hyperlink la un buton sau o imagine.
 Din meniul Slide Show alege opţiunea Action Buttons. Selectează butonul pe care doreşti să-l plasezi în slide.
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 După selectarea butonului dorit efectuează un clik în slide-ul în care doreşti să apară butonul respectiv. Va apărea caseta de dialog Actions Settings şi va trebui să apeşi butonul de opţiune Hyperlink To.
 Din lista derulantă Hyperlink To alege tipul de hyperlink pe care doreşti să-l ataşezi butonului. Acesta poate fi o adresă de site, un fişier existent pe hard disk sau un alt slide din prezentarea curentă. Execută apoi clik pe butonul OK pentru a închide caseta de dialog.
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 ADĂUGAREA UNUI HYPERLINK LA UN TEXT EXISTENT ÎN SLIDE
 Pentru a utiliza în crearea unui hyperlink un text existent în slide-ul în care doreşti să inserezi acest hyperlink trebuie să selectezi textul respectiv.
 Alege apoi meniul Insert şi selectează opţiunea Hyperlink.
 Textul selectat apare în câmpul Text to Display, dacă doreşti să-l modifici poţi să o faci în acest moment.
 Dacă doreşti să inserezi un hyperlink către o adresă de Internet sau către un fişier aflat pe hard disk trebuie să foloseşti butonul Existing File or Web Page. Cu ajutorul butonului Browse poţi căuta pe hard fişierul către care doreşti să faci legătura sau dacă ştii, poţi să introduci direct în câmpul Type the File or Web Page adresa URL sau calea către ceea ce doreşti să faci legătura.
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 Dacă doreşti să creezi o legătură la un alt slide din prezentare trebuie să foloseşti butonul Place in this Document.
 Apeşi apoi butonul OK şi hyperlink-ul este gata. Dacă doreşti să testezi legătura creată afişează slide-ul în modul de vizualizare Slide Show şi execută clik pe hyperlegătură. Adresa Web, slide-ul sau fişierul care corespunde legăturii făcute trebuie să se lanseze în execuţie.
 ASCUNDEREA UNUIA SAU MAI MULTOR SLIDE-URI
 De multe ori doreşti ca în prezentarea pe care o expui unele slide-uri existente în prezentare să nu fie afişate pe ecran sau nu doreşti să fie tipărite. Operaţia de ascundere a slide-urilor nedorite este extrem de simplă.
 În modul de afişare Slide Sorter View selectează slide-ul sau slide-urile pe care doreşti să le ascunzi.
 Foloseşte apoi meniul Slide Show şi execută clik pe opţiunea Hide Slide.
 Slide-urile selectate vor fi ascunse şi nu vor mai apărea în prezentare.
 Dezactivarea opţiunii de ascundere o poţi face efectuând operaţia invers.
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 OVERHEAD TRANSPARIENCIES
 În această secţiune a lecţiei vei învăţa cum poţi să tipăreşti o prezentare pe folii transparente şi apoi cum poţi să expui această prezentare cu ajutorul unui retroproiector.
 Pentru început trebuie să încarci în imprimanta în locul hârtiei obişnuite pe care o foloseşti la tipărire, folii transparente.
 În meniul File alege opţiunea Page Setup.
 Execută clik pe săgeata din dreptul casetei Slides Sized For, selectează Overhead din lista derulantă şi apasă butonul OK. Acum imaginile vor putea acoperi foliile transparente.
 Din meniul File alege opţiunea Print şi selectează din partea de jos a casetei care apare opţiunea Pure Black And White. Va fi tipărit pentru fiecare slide o folie transparenta..
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 VIZUALIZAREA ŞI PUBLICAREA UNEI PREZENTĂRI PE WEB
 Poţi să salvezi prezentarea creată în PowerPoint ca document HTML pentru a putea fi publicată pe Internet sau Intranet. Pentru aceasta trebuie să urmezi paşii următori:
 Din meniul File alegi opţiunea On-screen Show şi execuţi clik pe butonul OK.
 După ce prezentarea este deschisă din meniul File alege opţiunea Web Page Preview, va fi lansat programul Internet Explorer care va converti temporar fişierul prezentării în format HTML.
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 Executarea unui clik pe hiperlegaturile de text din partea dreaptă a prezentării va face saltul de la un slide la altul.
 Pentru a închide Internet Explorer şi a reveni în PowerPoint execută clik pe butonul Close al programului Internet Explorer.
 Pentru a converti prezentarea în format HTML din meniul File alege opţiunea Save As Web Page, execută apoi clik pe butonul Publish îi în următoarea casetă de dialog deselectează caseta de validare Display Speaker Notes şi lasă opţiunile din secţiunea Browser Support aşa cum sunt. Execută clik pe butonul Change pentru a da un nume prezentării.
 Verifică dacă calea de acces din caseta de editare File Name reflectă corect locul în care doreşti să salvezi fişierul HTML al prezentării.
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 Dacă doreşti ca prezentarea să fie disponibilă pe Internet şi pentru alte persoane trebuie să o copiezi pe serverul firmei. Pentru aceasta trebuie să afli de la administratorul de reţea calea de acces la locul în care doreşti să salvezi fişierul.
 REZUMATUL LECŢIEI 3
 În această lecţie ai învăţat:
 Să inserezi un hyperlink la o imagine sau un buton, să ataşezi un hyperlink unui text existent în slide.
 Acum ştii să ascunzi unul sau mai multe slide-uri dacă consideri că nu sunt necesare în prezentarea pe care o faci.
 Ştii de asemenea cum poţi să tipăreşti o întreagă prezentare sau anumite slide-uri pe folie transparentă pentru a putea folosi un retroproiector atunci când faci prezentarea.
 Ai învăţat să salvezi o prezentare în format HTML pentru a o putea publica pe Internet.
 ÎNTREBĂRI RECAPITULATIVE
 Întrebări grilă
 Bifaţi care consideraţi că este răspunsul corect. Întrebările pot avea de la 0 la 3 răspunsuri corecte. În cazul în care răspunsul corec nu se găseşte printre cele trei răspunsuri bifaţi căsuţa “Altul”.
 Prin intermediul cărei secvenţe de comenzi se realizează inserarea unui hyperlink?
 Insert => New Slide.
 Insert => Hyperlink.
 File => New.
 Altul.
 Prin intermediul cărei secvenţe de comenzi se realizează ascunderea pentru mai multe slide-uri?
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 File => New.
 File => Close.
 Slide Show => Hide Slide.
 Altul.
 Cum se tipăreşte o prezentare pe folii transparente?
 File => Page Setup => Overhead.
 File => Page Setup => Banner.
 File => Print.
 Altul.
 Cum poti sa salvezi o prezentare in format HTML?
 File => Save.
 File => Save As Web Page.
 Insert => New Slide.
 Altul.
 Completaţi
 Câte metode de ataşare de hyperlink-uri cunoşti? Descrie în câteva cuvinte aceste metode.
 La ce foloseşte salvarea unei prezentări în format HTML?
 Exerciţii
 Creează un hyperlink la o imagine pe care o ai salvat-o pe hard-ul calculatorului.
 Creează un hyperlink la un text pe care îl inserezi într-un slide deja creat.
 Ascunde unul sau mai multe slide-uri din prezentarea pe care ai creat-o.
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 Salvează în format HTML fişierul prezentării şi apoi vizualizează prezentarea salvată.
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